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Introduction
CoPre is a self-developed 3D data intelligent processing software by CHCNAV. It mainly
includes functions for LiDAR data processing and aerial survey image data processing,
converting data collected by LiDAR systems, orthophoto cameras, and oblique cameras into
outputs such as point clouds, panoramic images, orthophotos, and 3D models. As a link
between the collection and processing, CoPre features full functionality and greater
simplicity.

1 Installation

This chapter describes the requirements on the operating system, hardware devices,
installation and uninstallation of CoPre software, and precautions.

1.1 PC Hardware Requirement

Operating system Microsoft Windows7 (64bit)
Microsoft Windows10 (64bit)

CPU Minimum: 2+ GHz
Recommend: 3.5+ GHz

Memory Minimum: 16GB
Recommend: 64GB

GPU Only NVIDIA is supported, GTX1050ti and above
Graphics card driver after 2021

Display resolution 1920*1080 above

.NET environment .NET Framework 4.0
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Functions Specification

Optimization Minimum RAM：32GB

Recommended RAM：≥ 64GB

HPC Coloring Minimum RAM：32GB

Recommended RAM：≥ 64GB

Mesh Modeling Minimum RAM：32GB

Recommended RAM：≥ 64GB

3DGS Minimum RAM：32GB

Recommended RAM：≥ 64GB

Registration Minimum RAM：32GB

Recommended RAM：≥ 64GB

Blurring license plate&
human face

Minimum:

- GPU: 3050Ti series (6GB VRAM)

- CPU: Intel Core i7

- RAM: 32GB

Recommended:

- GPU: Beyond 3050Ti series (e.g., 3060Ti series or
higher, 8GB VRAM)

- CPU: Intel Core i7

- RAM: 64GB

Calibration Minimum RAM：32GB

Recommended RAM：≥ 64GB
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Using a high-performance graphics card:
If your computer has two graphics cards: one low-performance integrated graphics card and
one discrete graphics card with a high-performance processor, ensure the correct
configuration.
Note: The steps provided below are based on NVIDIA graphics cards. Please refer to the
documentation included with your graphics card, as the steps may vary.

Operational Steps:
1. Right-click on the desktop and select "ShowMore Options". From the pop-up menu,

choose "NVIDIA Control Panel".

Figure1-1 Opening NVIDIA Control Panel
2. In the opened NVIDIA Control Panel, select "Manage 3D Settings".

Figure1-2 Manager 3D Settings
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3. In the "Manage 3D Settings" panel, first click the "Global Settings" tab, then select
"High-performance NVIDIA processor" from the "Preferred graphics processor"
drop-down list.

4. In the settings below, modify the setting for the "OpenGL Rendering GPU" function to
the corresponding graphics card, click "Apply", then restart the software to process the
data.

Figure1-3 Modifying OpenGL Rendering GPU

1.2 Software Installation

Notes
Turn off 3rd party antivirus software in case the install process being interrupted. And the
install path need complete English letters.
 Open software package then confirm “I agree” on license terms and continue

installation:
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 Waiting software install completely:

 When software installed successfully, click finish to close current interface.
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1.3 Software Uninstall

First way, click “Start” to open windows start menu. Find CoPre 2 folder then click “Uninstall
CoPre2” and click yes to start uninstall.

Second way, go to “Settings – Apps”, and find CoPre 2 then right click to uninstall.
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2 Data Structure

This chapter introduces the engineering structure and data storage method used in CoPre
software solution

2.1 Project Structure

A complete CoPre 2 project structure contains 4 folders: GPS, IMG, SCAN and TRACE.

2.1.1 GPS

 Base: Need copy receiver static data inside. Support HCN and RINEX 3.02 formats.
 Ctrl: Storage control point file. Empty by default.
 Post: Storage POST file. Empty by default, and after POS process finished, user can

find .post file inside.
 Rover: Storage LiDAR GNSS data and IMU data.
 Rtk: Storage RTK data under none-base mode. Empty by default.
 Sync: Storage camera trigger data. Empty by default.
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2.1.2 IMG

This folder stores AA450 picture data. And CP is the configuration files of this set of camera
data.

2.1.3 SCAN

This folder stores raw laser data of LiDAR. And EP is the configuration files of this set of laser
data, which contains the lever arm information of antenna. Different drone will use
different .EP file as the antenna location is different.

2.1.4 TRACE

Storage test log data and normally is empty.
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2.2 Task Structure

A complete CoPre 2 task contains Reconstruction folder, Results folder, SolveProjects folder,
coc file, cpr file, crd file and db file.
 Reconstruction file is the temporary data folder generated during reconstruction.
 Results file is the final output result folder, including point cloud, orthophoto, model

and other result files.
 .coc file contains the project coordinate system information.
 .cpr file is the task project file.
 .db file contains the GCP information of ground control points.
 .crd file is the coordinate system file that produces the result.

2.2.1 Reconstruction Folder

Reconstruction folder is the temporary data folder, contains AT_Temp, DOM_Temp and
Model_Temp.

2.2.2 Results Folder

Results folder contains final output information after generate result in CoPre 2. Depends on
different processing modes, it might have 4 type folders: auto-solve result, adjust result,
refine adjust and adjust & refine together result.
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 AUTOSOLVE: For a complete auto-solve workflow, it should contain camera and
scanner folders with auto processed result files (picture, depth map, point cloud
data).

 ADJUST: For a complete adjust workflow, it should contain camera and scanner
folders with adjusted result files (picture, depth map, point cloud data).

 REFINE: For a complete refine workflow, it should contain camera and scanner
folders with refined result files (picture, depth map, point cloud data).

 ADJUST_REFINE: For a complete adjust & refine workflow, it should contain camera
and scanner folders with adjust & refined result files (picture, depth map, point
cloud data).

2.2.3 SolveProjects Folder

SolvedProjects folder contains intermediate output information after preprocess in CoPre 2.
Depends on different processing modes, it might have 4 type folders: GPS, REFINE, ADJUST,
SOLVED.
 GPS: For a complete preprocess workflow, it should contain base and rover folder

with relative GNSS & IMU files.
 SOLVED: For a complete preprocess workflow, it should contain preprocess files

with .codata format.
 ADJUST: For an adjust preprocess workflow, it should contain new adjust POST file

with .codata format.
 REFINE: For a refine preprocess workflow, it should contain new refine POST file

with .codata format.
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3 Software operation guidance

This chapter introduces the data processing flow of some special radars and common
functions that guide the use process.

3.1 Laser Data Processing of AA1400/AA2400/VZ2000i

Description
Add laser data processing function of AA1400/AA2400/VZ2000i in CoPre 2 need to install
third-party SW.
Step
 Prepare RiUNITE-1.0.3 software package, RiUNITE-1.0.3 software License, and RiUNITE

1.0.3 dongle.

 Double-click SetupRiUNITE.exe to enter the installation wizard, and install it to a non-C
drive directory to complete the installation.

 After the SW is successfully installed, open the LicenseCenter from the Start menu bar.
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 Click “Import…”，import .lic file.

 Click “Save/apply changes now!”.
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Notes
Import License file only once for each PC. You do not need to repeat the operation.
 Plug in the RiUNITE-1.0.3 Dongle. Copre will automatically convert rxp files to sdcx files

when processing data during data processing.

3.2 Laser Data Processing of AU900/AA1300/Alpha3D

Description
Add laser data processing function of AU900/AA1300/Alpha3D in CoPre 2 need to install
third-party SW.
Step
 Prepare RiUNITE-1.0.3 software package, RiUNITE-1.0.3 software License, and RiUNITE

1.0.3 dongle.

 Double-click SetupRiUNITE.exe to install with default Settings.
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 After the SW is successfully installed, open the LicenseCenter from the Start menu bar.
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 Click “Import…”, import .lic file.

 Click “Save/apply changes now!”.



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 16

Notes
Import License file only once for each PC. You do not need to repeat the operation.
 Plug in the RiUNITE-1.0.3 Dongle. Check the filter settings and choose MTA to process.

 CoPre will automatically convert rxp files to sdcx files when processing data during data
processing.

3.3 RS10 Data Processing Operation Flow

This chapter mainly introduces the processing flow of RS10 data in the CoPre software,
as well as the corresponding precautions. The data processing flow is as follows:
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3.3.1 Data Copy

After the RS10 completes data collection, connect it to the computer using a USB
Type-C data cable. Locate the collected data in the corresponding device drive letter and
copy it to the target folder.

Note that the device should be turned off before connecting to the computer;
otherwise, the computer will not be able to recognize the device’s drive letter properly.

Data Copy, In the RS10 -> ALPHA_ALL path, the raw data collected by the device is
stored. Each project’s data is kept in a separate folder, named either with the project name
set during collection using SmartGo, or by default with the time and SN number. Locate the
required project data for copying by its name or the collection time. Note that the path for
storing projects does not support Chinese characters.

For 1 hour of collected data, it is estimated to take about 5 minutes to copy. During
the copying process, the data integrity is automatically checked. The project data and
real-time point cloud data are copied together in one go, and the real-time point cloud data
can be used immediately after loading.
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The data organization structure in the RS10 mainly includes GPS data, camera data,
laser data, real-time point cloud data, log files, and intermediate files generated during
refinement processing.

3.3.2 Coordinate System Description

When creating a new project in CoPre, it is necessary to select the corresponding
coordinate system based on the project's requirements, which are divided into relative
coordinate system and projected coordinate system.

In cases where our results do not require absolute coordinates and only need relative
measurements, such as in indoor scenes for measuring room dimensions or calculating cubic
volumes, the coordinate system can be set to a relative coordinate system.

When our result data requires absolute 3D spatial coordinates, it is usually necessary to
set ellipsoid parameters, projection parameters, and coordinate transformation parameters
like seven parameters or four parameters. In such cases, the coordinate system can be set to
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a projected coordinate system.

The coordinate system should be chosen as a projected coordinate system when the
data meets any of the following conditions. Otherwise, select a relative coordinate system.

Condition 1: When using CORS data, log in to the CORS system during data collection,
and the working environment has good satellite signal reception and a fixed solution.

Condition 2: When using PPK processing, there should be both mobile station data ,
static data; during data collection, normal satellite search is achieved and a fixed solution.

Condition 3: When using trajectory control points, these points are added
simultaneously with data collection, each accompanied by its respective control point
coordinates.

Note: All projects under the same task can only use one coordinate system. If a project
requires a new different coordinate system, a separate new task needs to be created, and
then the project added to it.

3.3.3 Real-time Point Cloud Load and Export

The data processing of RS10 can be divided into two types: real-time point cloud
processing and secondary refinement processing, each corresponding to different
operational scenarios and requirements.

The viewing of real-time point clouds does not require additional software , it can be
loaded and viewed with one click using the preprocessing software CoPre. Within CoPre, not
only can basic measurements be performed on real-time point clouds, but it also supports
accuracy checks on real-time point clouds and the output of accuracy reports to avoid
submitting substandard results.

For real-time point cloud display, a new project must be created in CoPre and the data
loaded. When there are multiple projects within a task, the projects to be displayed in the 3D
view can be selected from the project list.
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Exporting Real-time Point Cloud Data: If we require universal point cloud data in LAS
format, click "Export Real-time Point Cloud" to convert the real-time point cloud data into
LAS format. Additionally, select the desired LAS version number, configure the file size of the
LAS output, and define a custom output path .Meanwhile, the parameter settings can be
applied to other projects.
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3.3.4 Optimize Data

When the accuracy of real-time point cloud data fails to meet our generation
requirements, the Optimize Data function can be employed to perform precision
optimization on the real-time point cloud data.

Refinement processing is applicable both in the local coordinate system and the
projection coordinate system. There are four types of constraints for refinement processing:
RTK, PPK (Post-Processed Kinematic) , Only SLAM or trajectory control points. Possession of
either one enables the refinement of the data.

RTK Usage Conditions, Scenarios, and Functions：

Usage
Conditions

Log in CORS account and satellite search is in good condition

Scenarios Operating in an environment with satellite data and a fixed solution

Functions
1.Increase trajectory accuracy and point cloud precision

2.Convert relative coordinate point cloud to absolute coordinates point cloud.

PPK Usage Conditions, Scenarios, and Functions：

Usage
Conditions

Mobile station equipped with GNSS Static data
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Scenarios Operating in an environment with
satellite data and a fixed solution

Cloud Base
Physical base

station

Functions 1.Increase trajectory accuracy and point cloud precision

2.Convert relative coordinate point cloud to absolute coordinates point
cloud.

Only SLAM Usage Conditions, Scenarios, and Functions：

Usage
Conditions

Don’t need the projection coordinates, need to use the relative measurement,
such as ranging, measured area, volume, etc

Scenarios If the GNSS can not be used in the field or in indoor operations

Functions 1. Compared with the real-time point cloud, and the relative accuracy is improved

Trajectory control points Usage Conditions, Scenarios, and Functions：

Usage Conditions Fieldwork has involved adding
trajectory control points

Control point coordinates

Scenarios It is required that the control points match the names of the trajectory
control points added during field operations.

Functions 1.Increase trajectory accuracy and point cloud precision

2.Convert relative coordinate point cloud to absolute coordinates point
cloud.

The workflow for Optimize Data：
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Optimize Data Workflow：

Step 1: Create Task

In the software, create a new task and set the coordinate system according to project
requirements.

Note: 1. The task name, task path, and data path must not contain Chinese characters.

2.When selecting raw data, ensure to select the entire folder containing the raw data
files. Choosing the wrong folder will result in a failed creation task.

3.Coordinate System Setup: If absolute coordinates are required for the final results, set
the coordinate system parameters according to the specific needs. If a relative coordinate
system is needed, opt for the selection of a relative coordinate system.

Step 2: Optimize Accuracy

Select Project: Click the ' Optimize Data' button. On the project selection interface,

check the boxes for the projects needing optimized processing; this operate supports batch
optimization for multiple projects.

GNSS setting：Select the corresponding GNSS calculation method according to the job
scenario and the requirements.
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a.When the CORS account is logged in during the operation, and the star search is good,
the RTK can be directly used for optimized data processing. Only select, PPK to optimize the
trajectory, no other Settings, the software will automatically refine processing.

b.When the mobile station has GNSS and static data, the PPK can be used for data
optimized processing. For static data, the CHCNAV cloud base station or a physical base
station can be used. If it is a third-party physical base station, it needs to be exported in the
Renix format, and the version should be 3.02 or above. At the same time, the antenna height
needs to be reduced to the phase center. If it is a CHCNAV base station, the output HCN file
will be automatically read by the software.

c. Only SLAM processing, no GNSS optimization, only using the SLAM algorithm to refine
the data processing, which is generally used in indoor scenarios.
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Trajectory Control Point Settings: If control points were added during field collection,
you can select the ‘TGCP Trajectory Optimization’ function to import control points for
matching with corresponding points, which can improve trajectory accuracy; if no control
points were added during field collection, skip this step.

Result Settings: Configure the point cloud processing options and output settings, then
start the Optimize Data processing.
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Description of the Result Settings

Format Conversion: In the SLAM processing module, or by right-clicking on the result
project and selecting ‘Format Conversion’, select the desired format and path for result
conversion.”

Note: The Auto Accuracy Optimization can directly generate LAS results in the set
coordinate system. For other coordinate types or point cloud formats, appropriate settings
can be made in the Format Conversion.

3.3.5 SLAMModeling

1. Hardware and software requirements
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1.1. Hardware requirements

RS10 needs to meet the following two requirements:

①The device's firmware version needs to be updated to 1.4.1 or above. SmartGo version
needs to be updated to 1.3.2.1 or above.

After SmartGo connects to the device, the firmware information will be displayed directly on
the interface. Before collecting data, you can check whether the firmware version meets the
requirements. If not, you need to update the firmware version first.

② The device must have modeling authorization. After SmartGo connects to the device,
click "Authorization Status" to check whether you have modeling permission. If not, you
need to re-authorize.
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Computer configuration requirements:

The SLAM modeling function has high requirements on computer configuration. For specific
parameter requirements, please refer to the following table:

CPU Intel-i7 or higher processors are recommended

Graphics Must be NVIDIA graphics card, 3050Ti and above
recommended

Memory 32GB or above recommended

disk Ensure that there is enough disk space. 1TB or more is
recommended.

operating system Win10/11

1.2. Software requirements

The SLAM modeling function is only available in CoPre v2.8.6 or above. Before SLAM
modeling, please check whether the software version meets the requirements. If not, click
“Update” according to the software prompt. User can contact CHC Navigation support to
obtain the latest software installation package.
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2. SLAMmodeling operation

This part only introduces the necessary process of SLAM modeling. If you want more details,
please refer to the "RS10 Surveying System User Manual".

The SLAMmodeling function can use point cloud and image data collected by RS10 to build a
3D model. (The data need to be processed first by optimization)

Right-click on the processing project and select "Modeling", or click the "Modeling" function
button in the menu bar to enter the modeling function panel.
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Select the project that needs to be modeled in the list. If you want to automatically load the
model after the modeling is completed, check "Automatically load the model after data
processing is completed". Click OK to start model processing.

Notes:

1. Pay attention to the remaining disk space and the estimated space required, and clean
them up in time to avoid failure due to insufficient space.

2. Pay attention to the computer configuration requirements. The computer configuration
will directly affect the efficiency of modeling.

3. Note that modeling requires exporting camera POS in optimization processing.

If optimization has not been performed yet, you can check "Output model data" in the
"Result Settings", and the software can continue with modeling after data optimization is
completed.
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Recommendation: After optimization, check point cloud data before modeling. For specific
inspection methods, please refer to the SLAM accuracy inspection in data processing in
chapter 5 of the “RS10 Surveying System User Manual”.

After SLAMmodeling is completed, the corresponding result data will be generated under
the Reconstruction->Model node.

Select the corresponding processing project, right-click, and click "Load Model" to view the
modeling result data in the 3D view.
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3. Output Model Result

After modeling is completed, right-click on the result node and click "Open

Directory".

You can view the location of the model result, including two common 3D model

format data, OSGB and OBJ, which is convenient for loading, browsing and modifying

models in third-party software or platforms.
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3.3.6 Data Quality Inspection

After data processing is completed, to ensure the quality of the data results and the
accuracy of the point cloud, it is essential to conduct inspections. In CoPre, using features
such as point cloud browsing, measurement, slice, and importing control points can check
the overall condition, relative accuracy, and absolute accuracy of the result data.

The overall condition check of the point cloud includes: completeness, presence of
distortion or deformation, presence of abnormal noise points, coloring, point cloud intensity,
point cloud density, etc.

Relative accuracy checks include: presence of stratification, verticality of the point
cloud, etc.

Absolute accuracy checks include: horizontal and vertical accuracy checks.

Note:1.When conducting relative accuracy checks of the point cloud, a full-area check is
required to ensure the overall effect of the point cloud. 2.For absolute accuracy checks, the
imported control points need to be consistent with the point cloud coordinate system and
the CORS system used.

4 Main Interface

This part includes task management, project management and window, as shown in the
following figure
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4.1 Task & Project

Task & Project mainly include Task Wizard, Create Task, Open Task, History Task, Close Task,
Coordinate and related Settings of the calculation project.

4.1.1 Task Wizard

Description

Create a new task wizard that guides users through processing data, divided into non-RS10
and RS10 data processing procedures.

4.1.1.1 The non-RS10 Task Wizard

Steps
 Click “Main – Task – Wizard” to start data import.

 On step 1, configure the task name, project data path, output data path, units and
task description (option). Then, click next.
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 On step 2, Coordinate system setting, the user clicks the button on the right side of
the coordinate system to set the coordinate system parameters.

 On step 3, select the data source and result type, the data source can choose laser
and image, and the output can choose laser point cloud, orthophoto image and 3D
model.
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 On step 4, configure the base settings to process POST file. Click “Next” to start
process, and the POST file will be loaded automatically when finish.

 On step 5, select target trajectories to process point cloud & picture data. Click “Next”
to start process.
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 On step 6, set the parameters related to the results, and then click “Finished”.
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 CoPre 2 will load result automatically when finished. User can view data on software
interface.

4.1.1.2 The RS10 Task Wizard

Steps
 Click “Main – Task – Wizard” to start data import.

 On step 1, configure the task name, project data path, output data path, units and
task description (option). Then, click “next”.
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 On step 2, CS(coordinate system) Setting, the user chooses to set the relative
coordinate system or projection coordinate system, detailed operation instructions
see the document "4.1.2 Create Task" section, click Next;

 On step 3, select the project and the user to select the project that needs to be
optimized, for the detailed operation instructions, see the "9.3 Optimize Accuracy"
section of this document;

 On step 4, PPK Trajectory Optimization, see the "9.3 Optimize Accuracy" section of
this document for detailed operation instructions;

 On step 5, TGCP Trajectory Optimization, see the section of "9.3 Optimize Accuracy"
of this document for detailed operation instructions;

 On step 6, Result Setting, see the "9.3 Optimize Accuracy" section of this document
for detailed operation instructions.

4.1.2 Create Task

Description
Create a CoPre2 task where multiple projects can be mounted into non-RS10 tasks and
RS10 tasks based on device type.

Steps
 Open “Main – Task – Create” to start data import.

 Configure task name, project data path, output data path, units and task description
(option). Finally, click “Create”.

Notes
 Both project data path and output data path not support non-English letters and

space. Save the data under English path.
 After clicking the “Create”, the coordinate system setting window will pop up. The

non-RS10 task and RS10 task are different. The non-RS10 task only has the projection
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coordinate system, and the RS10 task can choose the relative coordinate system and
the projection coordinate system. Set the coordinate system and click to confirm;

4.1.3 Open Task

Description
User can click “Main – Task – Open” or double click .cpr file to import an exist task.

Steps
 Click “Main – Task – Open” on toolbox and choose .cpr file to open an exist task
 User can also double click .cpr file in folder to open task.

4.1.4 History Task

Description
List all history tasks and switch between different tasks.
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Steps
 Click “Main – Task – Recent toolbox.

4.1.5 Close Task

Description
User can close already opened task.

Steps
 Select target task node.
 Click “Main – Task – Close” or right click selected node to close.

4.1.6 Coordinate

Description
Set the coordinate system for the current task.
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4.1.6.1 The non-RS10 coordinate system

Steps
 Click “Home – coordinate” on toolbox.

1 Customize Coord System: Select “Customize Coord System” and click “Custom or DatumRoot” to

choose a coordinate system, the coordinate information will be shown in the right window.

 Ellipsoid: Include Name, a, 1/f and positive direction.
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 Projection: Include common Gaussian, UTM, Mercator projection etc.

 Datum Transform: Include 3-parameters, 7-parameters, grid, grid(dgf format),
grid+7-parameters etc.

 Plane calibration: Include 4-parameters and best practice parameters.
 Elevation fitting: Include fixed difference, surface fitting, curve surface fitting and

best practice. Fixed difference requires at least one starting point. Surface fitting
refers to the elevation anomaly corresponding to multiple leveling points to generate
an optimal surface. When the surface is parallel to the horizontal surface, the surface
fitting is equivalent to fixed difference correction. This fitting method requires at
least three starting points. Curve surface fitting refers to the elevation anomaly
corresponding to multiple leveling points to generate an optimal paraboloid. The
curve surface fitting has a relatively high requirement on the starting data. If the
fitting result is too bad, it may cause the divergence of elevation correction number
in the work area. This fitting method requires at least six starting points. Best
practice can input the corresponding parameters according to the real situation.

 Geoid model: Users can choose a geoid file and interpolation method according to
the real situation. The software supports several kinds of geoid files, including none,
CGD file, GGF file, GRD file, BYN file, GSF file, BIN file, BYN file, GDF file, JASC file and
OSGB file.

 Plane grid: Supports plane horizontal east grid and plane horizontal north grid (CGD,
GRD, PXY, OSGB, DAT formats).

Note: Explanation on how to choose interpolation methods for geoid and plane grid:
1.Calculation speed: Bilinear interpolation > Quadratic interpolation > Spline
interpolation
2.Calculation accuracy: Bilinear interpolation < Quadratic interpolation < Spline
interpolation
3.In general, if the terrain is relatively simple, it is recommended to use bilinear
interpolation, which only considers the four points surrounding the current point as the
basis for interpolation;
4.If the terrain is complex, choose to use quadratic or spline interpolation, which will
consider more surrounding benchmark points and simulate a more complex surface.
Note: The central longitude of the current coordinate systemmust be within a 24° range
of the actual data's central longitude when setting projection parameters.
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2 Standard Coord System: Select “Standard Coord System” and click a coordinate system, the EPSG

coordinate information will be shown in right window.

Three methods to select standard coordinate system:

1) Search name or code of EPSG.

2) Select via drop-down list.

3) Select via recent usage.

Note：The EPSG information can only be recorded under standard coordinate

4.1.6.2 The RS10 coordinate system

Steps
 Select the task node, click "Main View-> Task Management-> Coordinate System",

pop up the coordinate system setting window, click Settings to enter the coordinate
system detailed setting interface;

 If you select the Relative Coordinate System, click to OK;
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If you select the Projected Coordinate System, the software will automatically select
the coordinate system based on the data. Click the setting button on the right side to set the
coordinate system parameters. The coordinate system setting is the same as non-RS10. See
"4.1.6.1 Non-RS10 Coordinate System" for this document.

4.1.7 Import Project

Description
Import raw project folder. There are two ways to import task, both support multiple tasks
import at same time.
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Steps
 After creating a new task, click “Main – Project – Import” or right click

RawWorkspace and choose import project to load. First way is import project from
LiDAR device directly; Second way is import project from PC local disk.

4.1.8 Import External Data

Description
User can import other camera data.
Steps
 Right click Task and choose to import external data to load.

 Choose image folder to load.
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 Click Import to import camera POS.

 After import, use “Separator” to divide contents. Make sure the column number is
corresponded to their contents (Name, E, N, H etc).
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 Click “OK” to import. After import successfully, choose import camera parameter to
load.

 Click “OK” to import.
 Configure the settings of sensor size and focal length, and finally click OK.
 During process, the process bar can be displayed under raw project.

4.1.9 Remove Project

Description
User can remove project data which include raw data, result data, preprocess data, adjust
data and refined data. If choose “Delete data” during remove, then the relative data folder
will be deleted.

Steps
 Select node part under raw project list.
 Click “Main – Project – Remove” or right click to remove current data.

Notes
For raw project, the delete option cannot be chosen by default. For processed data, user can
choose whether to delete during remove.

4.1.10 Project config

Description
Used for data processing for P330Pro with 3rd party camera.
Steps
 Click ”Project Management→Config Project” in the main view, the Config Project

window will automatically pop up;
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 Import base file, GNSS file, IMU file, click “Preprocess” to check whether the number
of photos and trigger are the same.
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 Import CP file and image data.

 Select the output directory, click “Start” to convert data, wait until the progress bar
to reach 100%.



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 53

4.1.11 Refresh Project

Description
User can refresh project if the raw project data changes.
Steps
 Select project folder in list, then right click and choose “Refresh Project”.
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Notes
User can select RawWorkspace and right click, then choose “Refresh Project”. All projects will
be refresh together.

4.1.12 POS Accuracy Curve

Description
Check the accuracy metrics of pos.
Steps
 Right click raw project to load pos accuracy curve.
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 Float/Fixed Ambiguity Status: Accuracy of Fixed Status is higher than Float Status.
 Fixed Ambiguity Status: Between 3 and 5.
 Float Ambiguity Status: Below 3.
 Quality Factor: According to the fixed ambiguity and estimation accuracy, range of

values from 1-7, the smaller the better.
 PDOP: Position Dilution of Precision, which can reflect the distribution of satellites,

range of values from 0.5-99, the smaller the better.
 Estimated Position: Represents the error of North/East/Height.
 Estimated Attitude: Represents the error of Roll/Pich/Heading.
 Combined Separation: Position difference values of forward and reverse solutions.
 Attitude Separation: Attitude difference values of forward and reverse solutions.
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4.1.13 Project Detail

Description
User can look over detailed information of project: laser data, camera data and GPS data.

Steps
 Click “Main – Project – Info” or right click to view details.

4.1.14 Open Directory

Right click any nodes under task manager to open directory folder path.
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4.2 WindowManagement

User can manage how to display all windows in CoPre.

 Layout: Click “Main – Window – Layout” , the software interface is displayed in the
default layout.

 Resources: Click “Main – Window – Resources” , show or hide the resources window.
 Trajectory: Click “Main – Window – Trajectory” , show or hide the trajectory window.
 3D Viewer: Click “Main – Window – 3D Viewer” , show or hide the 3D viewer

window.
 Output: Click “Main – Window – Output” , show or hide the output window.
 GCP: Click “Main – Window – GCP” , show or hide the GCP window.
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4.3 Vector Management

Description
The Vector Management Function includes importing, exporting, removing, and drawing
capabilities. The import feature supports importing KML, SHP, or DXF files to assist in
selecting tracks and modeling areas of interest. The export feature allows for exporting files
in SHP or DXF formats based on the selected trajectories.

4.3.1 Vector Import

Description
The import feature supports importing KML, SHP, or DXF files to assist in selecting tracks and
modeling areas of interest.
Steps
 Click on "Home -> Vector -> Import";
 After selecting a KML, SHP, or DXF file, click "OK," and the chosen file will be loaded

into the track view and 3D view;

4.3.2 Vector Export

Description
The export feature allows for exporting files in KML， SHP or DXF formats based on the
selected trajectories.
Steps
There are two ways to export vectors: exporting from loaded trajectories and exporting from
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selected vector nodes.
Method 1
Exporting from Loaded Trajectories: Choose the original project trajectories for export.
 Display the original project trajectories in the trajectory view, select the trajectories

you want to export, and click on "Home -> Vector -> Export."
 Click on "Export by trajectory", choose the file format (SHP or KML), and then select

the output directory to initiate the export.

Method 2
Exporting from Selected Vector Nodes: Select a vector node for export.
 In task management, select the vect++or, then click "Home -> Vector -> Export".
 Click on "Export by vector", choose the file format (SHP or DXF), and then select the

output directory to initiate the export.

4.3.3 Vector Removal

Description
This function is used to remove selected vectors.
Steps
 In task management, select one or more vectors, then click "Home -> Vector ->

Remove".
 Confirm in the popup dialog to remove the selected vectors. You can check the

option “Delete Data” to delete the vector.
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4.3.4 Vector Drawing

Description
This function is used to draw SHP format vectors in the 3D view.

Steps
 Step 1: Click on "Home-> Vector -> Draw";
 Step 2: In the 3D view, use the left mouse button to click and draw. Right-click to

access a menu for cancel and redrawing. Click "End" to conclude the drawing .

Menu Description
End(Ctrl+E): The vector's starting point and endpoint automatically connect to form a closed
vector, completing the vector drawing.
Cancel(Ctrl+Z): Go back to the previous drawing step.
RedrawCtrl+Y): Proceed to the next drawing step.
Exit(ESC): Exit vector drawing.
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5 Trajectory View

Trajectory view interface can display POS trajectory and control points. User can select part
of trajectory by point, box, polygon or timeline modes. Meanwhile, it also supports measure,
meridian line display and base map display etc.

5.1 Display

Description
Display project or result trajectory. If project contains control points, it will also display with
trajectory on interface. This function can be used under both raw project, preprocess project,
adjust, refine, and result nodes.

5.1.1 Display Trajectory

Select a project on left bar, then click “Trajectory – ” or right click project to display POS
trajectory.
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5.1.2 Hide Trajectory

User can uncheck the box of Pos to hide this trajectory.

5.2 Selection

User can select trajectory by point, box, polygon, or timeline modes. The selected trajectory
will display red color. If select under RawWorkspace, only red part trajectory will be
processed; If select under preprocess workspace, only red part trajectory will load processed
point cloud data.

5.2.1 Point Select

Description
User can select trajectory via points or box.
Steps
 Choose “Trajectory – ”. For point select mode, user can short click two points to

select the middle trajectory; For box select mode, user can long press left mouse to
draw a box and select relative trajectories.
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5.2.2 Polygon Select

Description
User can draw a polygon to select trajectory.
Steps
 Choose “Trajectory – ” and use mouse to draw a polygon to select trajectory.
 Left mouse: Draw a point of a polygon.
 Double click: End the final point of a polygon.
 Esc button: Withdraw to previous point.

5.2.3 Time Select

Description
User can select trajectory based on start time and end time.
Steps
 Choose “Trajectory – ”. Set a start time and finish time then click ok.

5.2.4 Append

User can select multiple trajectories if check this option. Choose “Trajectory – ”.
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5.2.5 Inverse

Description
Default is uncheck this option, which means process selected trajectory. User can also switch
to inverse mode, which means process unchecked trajectory.
Steps
 Check “Trajectory – ” option then select trajectory. The selected trajectory will

be displayed as black color.

5.2.6 Cancel Select

Description
User can cancel selected trajectory.
Steps
There are three different ways to cancel selection.
 Remove the last selection
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 Remove all selection

 Remove current highlight selection

5.2.7 Measure

Description
User can measure trajectory length or multiple lines measurement.
Steps
 Choose “Trajectory – ” and left click to select points on interface, and double

click left button to stop measure. Click “Measure” again can quit measurement
mode.
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5.3 Slice

The slicing function of the track view supports the automatic display of slicing on the track
and the generation of slicing reports.

5.3.1 Auto Slice

Description
This function can be used on preprocess or result to show cut lines on trajectories to
determine point cloud overlap status.
Steps
 Select target project node which contain point cloud data, then click “Trajectory

– ”. The overlap status will be displayed with different colors. User can configure
the cut line parameters in settings. Finally, user can click “Trajectory – ” to
output screenshots & reports.

5.3.2 Slice Analyze

Description
User can click each cut line to open a slice window to check overlap status.



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 68



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 69

Steps
 Display POS trajectory which contains point cloud data.
 Check “Trajectory – ”, then choose any cut line to open a slice analyze window.

 User can configure the slice width to update a new slice.
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 User can click measure icon and hold left mouse to measure.

 User can change the view to real ratio by click magnifying glass icon.
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5.4 Render

Set the display and rendering modes of POS track and point cloud on Track View and point
Cloud view

5.4.1 Render Set

This section describes how to adjust the trajectory view rendering, including adjusting the
trajectory rendering type and time rendering format.

5.4.1.1 Render Types

Description
CoPre 2 can display trajectory accuracy based on different attributes of POS: Quality factor,
calculated satellites, fix/float, PDOP, 3D accuracy, 2D accuracy and height accuracy.
Steps
 Click “Trajectory - ” to select different attributes.

5.4.1.2 Time Format

Description
User can configure whether display UTC standard or absolute time.
Steps
 Click “Trajectory - ”, user can choose whether UTC standard or absolute time.
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5.4.2 Map Settings

Adjust the Settings related to the offline map, including the display of the current track
longitude and the import of the offline base map.

5.4.2.1 Show longitude

Description
CoPre 2 can show current trajectory longitude with 3-degree or 6-degree.
Steps
 Click “Trajectory - ”, user can see longitude on interface, and default is 3-degree.

5.4.2.2 Show map

Description
Show trajectory on map. Online map need network connected; Off-line map need built a
server by enter address to download.

Online map
Steps
 For online map, click “Trajectory - ”, map settings dialog will pop up. Check the

map button, and you can select OpenHumanitarianMap, GoogleMaps map from the
dropdown menu on the right.
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 In the networked environment, the software will automatically load the map for
display.

Off-line map
Steps
 Click “Trajectory - ”, map settings dialog will pop up. For off-line map, it

supports two options to load: First, load offline map by import .db3 file; Second, load
offline map by server address.

 Check the map button to display the offline map.

5.4.3 Layer

User can choose which layer need to be displayed on interface.
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5.4.3.1 Show/hide GCP

Description
User can show/hide different types of GCP: Check points, paired points or GCP name.
Steps
 After display trajectory, the trajectory view interface will show control points also.

Click “Trajectory – Layer – Refine points” to hide this layer on interface. User can
click again to activate display.
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5.4.3.2 Show/hide direction

Description
CoPre 2 can show or hide trajectory direction.
Steps
 After display trajectory, user can choose to show or hide direction arrow on

trajectory.

5.4.3.3 Show picture number

Description
CoPre 2 can show or hide picture number.
Steps
 After display trajectory, user can choose to show or hide picture number.

5.4.3.4 Show base station

Description
CoPre 2 can show or hide base station.
Steps
 After display trajectory, user can choose to show or hide base station.
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5.4.4 Display Point Cloud

Description
User can select trajectory to display point cloud. This function is activated by default.
Steps
 After display trajectory, click “Trajectory - ”user can select processed trajectory to

display point cloud.

5.5 POS skip

Description
In the position where the vehicle data is parked for a long time (such as equal traffic lights),
the POS track may jump, resulting in the distortion of the laser data there. The POS jump
repair function can smooth the skip area to solve the problem of point cloud distortion.
Steps
 When displaying the trajectory of the original project, pre-processing project,

correction project or adjustment project, the software will automatically detect the
skip of the POS data. If there is a skip, there will be a corresponding prompt in the
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output, and the jump area on the track will be displayed in different colours.

 Right-click on the POS displayed in the task management bar, and you can choose to
repair POS

 Set the relevant parameters in the pop-up repair POS dialog box, and click the
confirm button to start repairing POS.
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Notes

 Smooth Distance: Extend the threshold before and after the jump point for
smoothing.

 Detect Threshold：The actual size of the detected jump.
 Convergence interval: Indicates the accuracy of POS repair
 Time: POS skip repair area, which can be manually deleted or added
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6 3D View

Point clouds interface contains multiple functions: Point cloud render type, view, 2D/3D
switch etc. User can also make a slice or measurement based on point cloud data.

6.1 Point Cloud Colorization

CoPre 2 supports multiple colorization functions: Height, intensity, single, RGB and strip. User
can also configure the settings range and point size.

6.1.1 Color by Height

Click “3D View - ”,point clouds will be colored by height under this mode.

6.1.2 Color by Intensity

Click “3D View - ”,point clouds will be colored by height under this mode.
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6.1.3 Color by Height & Intensity

Point clouds will be colored by intensity & height together under this mode.

6.1.4 Color by precision

Click "3D View-> " , the point cloud colors by precision.
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6.1.5 Color by number of returns

Click "3D View-> -> ," and the point cloud will be colored by number of returns.

6.1.6 Color by return number

Click "3D View-> -> ," and the point cloud will be colored by return number.
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6.1.7 Color by single project

Click "3D View -> ," and the point cloud will be colored by project, different projects will

be displayed in different colors.
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6.1.8 show/hide the colorbar

Click "3D View -> " to show/hide the color bar .

6.1.9 Color by Single

Click “3D View - ”,point clouds will be colored by different colors based on different files
under this mode.

6.1.10 Color by RGB

Click “3D View - ”,point clouds will be colored by real RGB color under this mode.

6.1.11 Color by Intensity & RGB

Point clouds will be colored by intensity & RGB together under this mode.
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6.1.12 Color by Strip

Click “3D View - ”,point clouds will be colored by different colors based on different strips.

6.1.13 Color Parameter Settings

User can configure parameters on “Settings”. Click “Reset” to restore default settings.
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6.1.14 Points Size Settings

User can configure point cloud size based on these settings.

6.2 View Settings

User can switch multiple view angles to display point cloud data on interface.

6.2.1 2D/3D Switch

Click “3D View - ”,this function support 2D and 3D view switch displaying, and default is
3D display. Click it again to switch 2D view.
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6.2.2 Direction

CoPre 2 supports multiple eye view directions: Front, back, left, right, top and bottom.

6.2.3 Full Extent

User can “3D View - ”, to display point cloud data at center by default.

6.3 Point Cloud Clipping

Description
This function is used for point cloud clipping to remove noise.
Steps

 Click "3D View -> " to activate the clipping command, and the clipping mode
window will pop up.
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Parameter Description for Clipping Modes:
(1) Bounding Box Clipping mode

Supports displaying and retaining point clouds inside or outside the bounding box.
When used with polygon clipping, point clouds can be clipped based on the
bounding box display. When saving the point cloud, the displayed point cloud range
in the current view will be retained.
Bounding box size: Supports manual input/view operation to update the clipping
space range; view operations will trigger real-time changes in values to accurately
fit the point cloud range.
Adjusting the bounding box in the view:
①(cube): Controls the overall translation of the bounding box;
② (pyramid): Controls the translation of each face of the bounding box;
③ (ring): Controls the rotation angle of each face of the bounding box;

(2) Polygon Clipping mode

Rectangular selection: Draw a rectangular frame to select point clouds by clicking the
mouse; the selected point clouds will change in rendering color.

Polygon selection: Draw a polygon to select point clouds by clicking the mouse, with
double-click to end the drawing; the selected point clouds will change in rendering color.

Operation mode: The retention method for the drawn polygon area, supporting adding
the current selected range to the clipping range or removing it from the clipping range.

Application mode: Select the effective range of clipping. Select "Interior clipping" to
retain point clouds outside the selected area and clip those inside; select "Exterior clipping"

to retain point clouds inside the selected area and clip those outside.

Reset: Restore the originally selected or clipped point clouds to their original state.

Save: Save the clipped point cloud to overwrite the original one.

Adjust the size and position of bounding box:
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The point cloud before adjusting

The point cloud after adjusting
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(3) Select Rectangular Mode (or Polygon Mode), draw a rectangle (or polygon) on
the point cloud, then click Interior Clipping (or Exterior Clipping).

The selected point cloud area

Interior Clipping
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Exterior Clipping

(4) Click “Save”, then click “OK” in the pop-up window. When the progress bar
reaches 100%, it indicates that the point cloud clipping has been completed.
Note: The clipped point cloud will overwrite the original one and be
automatically reloaded into the 3D view.

6.4 Measurement

Measurement tool includes point measurement, density measurement, distance
measurement, and area measurement.

6.4.1 Point Measurement

Description
This function is used to measure the coordinates, RGB, intensity, time, echo, scan angle, scan
direction, and point source ID of a point cloud.
Steps

 Click "3D View -> " to activate the measurement command. Select "Point

Measurement" from the pop-up menu to open the point measurement window.



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 91

 Click on a point , and the measurement information for that point will then appear.

Note: Point measurement is only effective for measuring the point cloud.

6.4.2 Density Measurement

Description
This function is used to measure the density of the point cloud.
Steps

 Click "3D View -> " to activate the measurement command. Select "Density

Measurement" from the pop-up menu to open the density measurement window.

 Set the length, then click on the point cloud you want to measure. The point cloud
density information within the red box will be displayed in the window.



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 92

Note: Density measurement is only effective for measuring the point cloud.

6.4.3 Distance Measurement

Description
This function is used to measure distance.
Steps

 Click "3D View -> " to activate the measurement command. Select "Distance

Measurement" from the pop-up menu to open the distance measurement window.

 Step 2: Measure the distance on the point cloud by clicking with the mouse to start
drawing a line and double-clicking to finish the line segment.
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6.4.4 Area Measurement

Description
This function is used to measure area.
Steps

 Step 1: Click "3D View -> " to activate the measurement command, then select

"Area Measurement" from the pop-up menu.

 Step 2: Click to select points and double-click to finish drawing a closed region on the
point cloud. The region will be highlighted, and the area will be displayed.



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 94

6.5 Select

Description
User can use this function to pair GCP with point cloud data. Activate by default.
Steps
Click “3D View - ” to activate this function, then select point on interface. There are
three ways to select:
 First, use “Ctrl” button and left mouse to select.

 Second, use “Shift” button and left mouse to draw two cross lines to select (press Esc
button to cancel selection).
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 Third, use “Alt” button and left mouse to draw three points to design a circle, and
circle center point will be selected automatically.

6.6 GCP/TGCP Display

Display
User can display or hide GCP/TGCP information on interface.
Steps
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 Click “3D View - ” to display or hide GCP/TGCP.

6.7 Trajectory Display

Display
User can display or hide trajectory on interface.
Steps

 Click “3D View - ” to display or hide trajectory.
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6.8 Slices

User can make a horizontal slice based on point cloud data, which can display all points on
this elevation.

6.8.1 Hz Slice

Steps
 Click “3D View - ” and click mouse wheel to select a location first. CoPre 2 will

generate a section based on this elevation and left bottom interface will display this
elevation.

Shortcut key: “Q”: Open, “E”: Exit clip mode. Press Ctrl and mouse wheel to move section.

6.8.2 Vertical Slice

Description
Click “3D View - ” .User can check point cloud thickness or overlap via a vertical slice.
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Steps
 Check “V Slice”, then left mouse to select two points to create a vertical slice. Press

“Esc” to cancel.

6.8.3 Clip Param Settings

Description
Click “3D View - ”. User can configure thickness settings on horizontal & vertical
directions.
Steps
 Configure settings and finally click confirm to save
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6.9 Show/hide the point cloud and pictures

Description
After displaying camera POS, the point cloud and picture icon appears in the 3D view, and
can control the display / hide the point cloud and pictures.

Steps

 Click "3 D View-> " to control the display / hide point cloud;

 Click "3 D View-> " to control the display / hide pictures;
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6.10 First Person

Description
Browse the point cloud in first-person mode, which is only available for SLAM point cloud
data or models.
Steps
 Load the SLAM results project and display the point cloud data, or load the SLAM

model data;

 Click “Three-Dimensional View-> ” to pop up a window with first-person operation

instructions;

 After clicking confirm, you will enter first-person mode and can operate according to
the key instructions in the first-person operation guide.
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6.11 Camera exposure point

Description
Browse non-panoramic camera photos and panoramas.
Steps
 Load the result track, and the 3D view will show the non-panoramic camera

exposure points (triangles shape point) and the panoramic camera exposure points
(circles shape point);
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

 Double-click the exposure point to enter the photo browsing mode. The 3D view will
display a non-panoramic camera lens switch button (there is no such switch button
for the panoramic camera exposure point) and an exit photo browsing mode button，
You can browse photos taken by different cameras (panoramic camera or built-in
camera) at the same exposure point by switching cameras;

 Click “3D View -> ” Point cloud can be shown/hidden，Click “3D View -> ” Can
show/hide photos，Click “3D View -> ”，to exit the photo browsing mode.
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7 3DGS View

Description
For browsing 3DGS model by SLAM Data. It’s contains first-person browsing, third-person
browsing, point measurement, distance measurement, and perspective reset functions.

7.1 First Person

Description
As the perspective of first-person to browsing 3DGS model.
Steps
 Right-click the 3DGS model and select Load, and the first-person operation prompt

will pop up automatically.

 Click "OK" to browse the model.
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7.2 Third Person

Description
Browse the 3DGS model from a third-person perspective.
Steps

 Click“3DGS View-> ”, Activate third person browsing mode to browse the model.

7.3 Measurement

7.3.1 Point Measurement

Description
Used to measure the coordinates of points on the model.
Steps
 Click“3DGS View-> ”, Activate the measurement command and select point

measurement in the pop-up menu;
 Click a point on the model, and the measurement information of that point will pop

up.

7.3.2 Distance measurement

Description
Used to measure distance.
Steps
 Click“3DGS View-> ”, Activate the measurement command and select distance

measurement in the pop-up menu;
 Draw lines on the point cloud by clicking and double-clicking to measure distances.
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7.4 Perspective Reset

Description
Used to restore the 3DGS model to its initial position.
Steps
 Click“3DGS View-> ” This will restore the model to its original position.

8 Processing

This section includes ten functions: one-click calculation, download cloud base station,
POS calculation, data calculation, strip adjustment, Link List, control point inspection, control
point correction, export results, pause, and cancel, as shown in the figure below:

8.1 Auto solve

Description

This function is divided into 5 steps: Select Project, POS Setting, Select Area, Solve Setting,
Result Export. Users can set all required parameters before Data Solving and then wait for
the Data Solving to complete.

Step
 After creating a task and importing the original project, click Toolbar -> Processing ->

Auto Solve;
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 The Auto Solve dialog box will pop up. In Step 1: Select Project, check the projects
that need to be processed, and click Next ;

 Enter Step 2: POS Setting, set the POS-related parameters. You can either download
the Cloud Base Station or import a Field Base Station. After setting, click Next ;

Note: For operations related to POS settings, please refer to section '8.2 POS Solve'
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 Enter Step 3: Select Area, where you can choose the all solved or select trajectory
solved; When selecting trajectory solved, the trajectories will be displayed. Select
the trajectories that need to be processed, and click Next ;

Tip: For operations related to trajectory selection, please refer to this document '5.2
Selection'

Note:

① The currently displayed trajectory is not the final calculated one, but rather a rough
trajectory recorded by the device itself through satellites, used only for selecting the
data calculation area;

② The option to select trajectory calculation is only available for airborne data;
vehicle-mounted or backpack data cannot be selected.

 Enter Step 4 Solve Settings to set calculation parameters for photo calculation, point
cloud calculation, and other processing. After setting, click Next;

Tip: For operations related to calculation settings, please refer to this document '8.3
Data Solve'
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 Enter 'Step 5 Result Export', set the export parameters for the laser and camera, and
click Start;

Note: For operations related to result export, please refer to section '8.7 Export
Results'

 After waiting for the one-click operation process to complete, you can load the result
data to view the point cloud and images.
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8.2 POS Solve

Description
If the raw project does not contain POST file, then user need to process POST file first.

Notes
CoPre 2 use CHCNAV own algorithm to process POST. It supports two types of base static
data: HCN format and RINEX 3.02 format.

8.2.1 Operation steps

Steps
 Select target project under task manager list, then choose “Processing– POS”
 If the Base folder contain static data (HCN or RINEX 3.02), then software will load it

automatically. User can also manually add or delete extra base station data by click
“Add” and “Remove”.
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Settings for loosely coupled and tightly coupled algorithms
There are two algorithms for POS processing: loosely-coupled mode and tightly-coupled
mode. The loosely-coupled mode is suitable for airborne open environments, while the
tightly-coupled mode is suitable for complex automotive environments.
The software will automatically select the appropriate processing mode based on the type of
data. For airborne data where the performance of the loosely-coupled processing mode is
not satisfactory, the tightly-coupled mode can be used as an alternative solution.

Notes
When multiple groups of data base station data are the same, after modified the base station

coordinate, antenna settings or ephemeris data settings of a data, can click "Batch Settings" to modify

the base station coordinate, antenna settings and ephemeris settings of other data in batches.

 User can configure “Enabled” option for different base stations to decide use or not
use.

 Users need to set base station at a known coordinate, then manually input
coordinate to get accurate result.

 Finally, click “Ok” to start POS process.

When processing data from AP5, check the POS optimization function, use SLAM and INS
tightly coupled solution to improve POS accuracy, can repair POS jumping.
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8.2.2 Add / Remove bases

Description
If the base file is RINEX 3.02 format or HCN format, users can manually add or remove base
stations.
Steps
 Click ”Add”, select the base station file, click “Open”, and the software will load the

base station file selected by the user.

 Select the base station to be removed, Click ”Remove”.
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8.2.3 Set base coordinate

Description
In order to ensure the absolute accuracy of the result data, the solving needs the accurate
coordinates of the base station.

8.2.4 Antenna Settings

Description
If the base file is HCN format, user can configure the antenna settings; If the base file is
RINEX 3.02 format, user can only configure “Antenna Height”.
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 Measured height: Height from ground control point to base receiver. Input antenna
height before static record will be read here automatically.

 Measure to: Configure 4 different method ways: slant height, vertical height, phase
height and unknown.

 Manufacturer & type: Receiver type, read from HCN file.
 Sampling Rate: Static rate, read from HCN file.
 Antenna Height (to phase center): If the base file is HCN format, this value is

automatically calculated based on measured height, measure to and receiver
antenna type, cannot manually change; If the base file is RINEX 3.02 format, this
value can be changed manually.

8.2.5 Select From Library

Description
User can save used base coordinate into library, or directly select from library.
Steps
 After input base coordinate, user can click “save to library” for storage. Set the base

name, coordinate, description and finally click “Save”.
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 User can click “Select” to load stored base coordinate for next time using. Click “load”
to import base information for POS process.

The base library file will be saved with .db suffix, and the default path is
D:/BaseStationLibrary.db. User can also change the path & name for storage.
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8.2.6 Ephemeris Data

User can click “More” to configure constellation system based on requirement: GPS, Beidou,
GLONASS, Galileo and QZSS.

In the “Settings” interface, click the “More” button, then you can see the “Advanced
Settings”, where you can set whether to enable the “Atmospheric Estimation”.

Atmospheric Estimation: If the base station is far from the survey area, it is recommended to
enable this setting to improve pos accuracy.

8.2.7 Advanced Settings

Description
If the physical base station is far from the collection location or when the cloud base station
solution is poor, estimating the atmosphere can improve POS accuracy.
Steps
 Click "More" and check "Estimate atmosphere" in advanced settings.
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8.2.8 DMI Function

Description
It can optimize the vehicle-mounted POS jump problem and improve the POS accuracy in
long-term environments without GNSS signals (such as long tunnel scenarios).
Steps
 Click "More", check "DMI Settings->Use DMI", and set the arm length parameters.

Note: The firmware version of the vehicle-mounted device needs to be upgraded to 1.18.5
and above and requires a hard-axis wheel encoder. Currently, only AP7 devices are supported
.
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hard-axis wheel encoder：

8.2.9 Generate POS Report

Description
POS report can be used to check the quality of POS accuracy.
Steps
 Select raw project on list, then right click to generate POS report.
 When the POS report generated successfully, can right-click "Open POS Report" on

the original project to open the POS report.
The POS report is as follows:
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Note： For airborne data, please display and select the track before displaying the POS
accuracy report.

8.3 Data Solve

Description
After selecting the trajectory through the original project, point clouds, photos, depth maps,
and colored point clouds will be generated, and the files will be saved in the Results folder.

8.3.1 Operation Steps

 After creating a new task and importing the original project, click Toolbar ->
Processing -> Data Solve (You can also right-click on the data node to select Data
Solve);

 A dialog box for data solve settings will pop up. Check the data to be processed in
the project list on the left, set the relevant parameters, and click confirm to start the
calculation:
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Note:

There are some differences in settings between airborne and ground vehicle. The
software has designed a set of commonly used default parameter settings for various types
of data. Users can directly click confirm to calculate using the default parameters or modify
the relevant settings as needed before proceeding with the calculation;
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8.3.2 Parameter Template Settings

Export Template: Exports the parameter template file of the current project for subsequent
parameter configuration.

Import Template: Supports importing parameter template files for the same carrier and
device, enabling quick parameter setup during data processing. Imported parameter
templates are saved locally and applied as the default settings for the same carrier and
device next time.

8.3.3 Pictures Processing

The Pictures Processing is going to rename and organizing pictures, and generates POS
files for the photos. The default naming of photo files will start from serial number 1.

Pictures processing setting:

Pictures Processing: When photo data is available, it is checked by default. When
checked, the photo data will be organized; if not checked, the photo data will not be
processed. If you want to color the point cloud, this option must be checked.

Blurring Privacy: Blur processing for license plates/faces in photos from vehicle-mounted
data.

Comparison of photos before and after privacy blurring:
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Comparison chart of photos before and after privacy blurring

Note：

1. If the GPU driver is prior to version 466.77(May 2021), it needs to be updated to
ensure that AI coloring and privacy blurring can be run properly.

2. Privacy blurring requires an NVIDIA graphics card with the following minimum
specifications: NVIDIA GeForce 3050Ti series 6GB VRAM or higher, Intel Core i7 or
higher CPU, and 32GB or more of systemmemory.

3. To reduce the installer size, the advanced functions of the vehicle-mounted were
placed in the Resource Pack Downloader. If users want to use AI coloring or
privacy blurring functions, they need to download them in advance.

Advanced Settings: Includes writing EXIF and time delay settings.

Write EXIF: Not checked by default; when checked, location information can be written
to pictures.

Time delay: Default is 0 seconds; if there is a time delay for the photos, this can be set.

Note:

After checking the Pictures Processing, all photos in the original data will be renamed
and stored in the original project path …\IMG\Camera1.
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8.3.4 Point Cloud Processing

The point cloud Processing options can generate result point cloud data. When checked,
the point cloud data will be calculated; when unchecked, the point cloud data will not be
calculated. This mainly includes color settings, mask settings, sampling rate settings, and
advanced settings.

Airborne (Left) Ground Vehicle (Right):

8.3.4.1 Point Cloud Color Settings

Point cloud coloring is based on the point cloud and photos to generate a color point
cloud with RGB information. It is checked by default; after checking this option, it will
generate a color point cloud.

Note:

To perform point cloud coloring, the original data must include camera data, and the
'Pictures processing' option must be checked when generating results.

Point Cloud Coloring Parameters:

Remove unshaded points: Default is unchecked; when this option is checked,
uncolored points will be deleted.

Uncolored Points Not Deleted (Left) Uncolored Points removed (Right):
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Blend Colorization: This option is only available for vehicle-mounted data. Enabling it
can significantly improve the color difference issue between adjacent panoramic images of
vehicle-mounted data, but the calculation time will also increase accordingly.

Blend Colorization Comparison Effect:

8.3.4.2 Mask Settings

Available only for vehicle-mounted data; click the more button on the calculation
interface to set it up, used to address coloring issues caused by vehicle occlusion during
photo coloring.

Mask setting parameters:

Use Cover Radius: Default value 8.5m, with the device at the center, point cloud data
within the set radius is colored using the last photo taken, to address the issue of the
vehicle's front being colored onto the ground;

Use Mask File: You can manually draw or import pre-drawn mask files, which can solve
the problem of the vehicle's front not being completely removed caused by the car body
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that’s overly long;

Note: For specific mask operations, please refer to the section '8.3.3.3 Image Mask

Settings' of this document.

No mask file used (left) Mask file used (right):

Using AI Mask: Automatically removes vehicles using AI algorithms to avoid coloring
other vehicles onto the ground, enhancing the coloring effect;

Without AI Mask (left) Using AI Mask (right):

Note:

1. AI Coloring requires an NVIDIA graphics card with the following minimum
specifications: NVIDIA GeForce 3050Ti series or higher, Intel Core i7 or higher CPU,
and 32GB or more of system memory.

2. Before using AI coloring, you need to download the vehicle-mounted photo AI
processing resource pack in "Help -> Resource Pack Downloader".

3. If the graphics card driver is older than version 466.77 (released in May 2021),
you need to update the graphics card driver to run AI coloring.
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4. When the panoramic/single-lens AI coloring function is used for the first time on
the computer, the panoramic/single-lens AI model files will be initialized, which
takes approximately 10 minutes.

8.3.4.3 Image Mask Settings

Available only under vehicle-mounted data; select the option to use the mask file, click
the mask settings button, and the image mask dialog box will pop up;

Steps

 When entering the image mask window, the software defaults to the image drawing
function and automatically loads a panoramic image, as shown in the figure below;

 Click the left mouse button to draw the masking area, covering the carrier vehicle.
Double-click the left mouse button to finish drawing, as shown in the figure below;
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 Click the save button, and the software will perform masking processing on the
drawn area, saving the mask file in the IMG folder of the data. After the masking is
completed, close this window, and subsequent Data Solving will automatically use
this mask file;

Interface Function Button Description:

Used to activate the masking drawing function, draw with the left mouse button,

and double-click the left mouse button to finish drawing;

Used to clear the drawn masking area;

: Used to display or hide the drawn mask area;
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: Used to import the drawn mask file;

: Used to export the currently drawn mask file, which can be directly imported

into other projects using the import function.

8.3.4.4 Strip Adjust

Currently, this option is only available for specific equipment data, primarily used to
improve the accuracy of point cloud data and data layering phenomena.

8.3.4.5 Sampling rate settings

There are four levels: 100%, 75%, 50%, and 25%, with the default value set to 100%.
The software will perform sampling on the point cloud data based on the set percentage.

8.3.4.6 Advanced Settings

Click the 'Advanced Settings' button to enter the advanced settings page, which mainly
includes static filtering settings, laser filtering settings, and other options;

Advanced Settings Page for Airborne Laser:
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Advanced Settings Page for Vehicle-mounted Laser:

Static Data Filtering: This option is only available for vehicle-mounted data and is not

checked by default. It determines whether the current speed is below the set threshold. If it
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is below the threshold, it is considered a stationary state, and point cloud data in a stationary

state will not be processed.

MTA Data Solving: This setting is only effective for Riegl series laser equipment and

AU20 /AA15 device data. When checked, it can process noise points across aerial intervals;

Place unprocessed points within possible cycles: This parameter is used to address the

issue of missing power lines in Riegl data after MTA processing.

Note: Riegl series laser equipment data requires the insertion of RiUNITE-1.0.3
software dongle to perform MTA processing. Detailed operation steps can be referenced in
this document '3.2 Laser Data Processing of AU900/AA1300/Alpha3D'.

Circle noise filter: Default is low, used to filter ring noise points near the point cloud.
Low, medium, and high represent the noise reduction strength. It is recommended to use the
high option when there are many noise points. Specific settings can be referenced in this
document '15 Parameter settings' ;

Field of View Filtering: Generally applied to airborne. The field of view angle represents
the angle of the actual scanned points relative to the equipment. The field of view angle
directly below is 0, and only point cloud data within the set threshold range will be
calculated;

3D Distance Filtering: Default checked. The default filtering value may vary depending
on the laser type. When checked, it will filter out points whose three-dimensional distance
from the scanner is out of range. Parameter values can be modified as needed;
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Intensity Filtering: Default checked. The default filtering value may vary depending on
the laser type. When checked, it will filter out points whose intensity values are out of range.
Parameter values can be modified as needed;

Height Distance Filtering: Default unchecked. When checked, you can set the minimum
and maximum elevation values, which will filter out points not within the elevation filtering
range. The origin of elevation filtering is the laser center, with upward being positive;

Noise Filtering: By default, not checked. When checked, set the distance threshold

parameter. The jump noise filtering filters out jump noise in the air. The noise determination

condition is: taking the current point as the center of a sphere, with the set threshold as the

radius. If there are fewer than 5 points within the sphere, the point is considered noise. For

detailed explanation, please refer to this document '15 Parameter settings' ;

2D Distance Filtering: By default, not checked. When checked, you can set the planar

distance, and the software will filter out points that exceed the range of the laser center

planar distance;

Low Point Filtering: Unchecked by default. If checked, you can set a distance threshold and
the software will filter out noise points below the ground that exceed the set threshold.



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 131

Coloring Mode: There are two shading modes: single-lens shading and panoramic shading.
Compared with panoramic shading, single-lens shading has better shading accuracy and
occlusion processing effects.

Note: If you need to use the single photo coloring function, please contact after-sales
technicians.

Filter Tower Shadows: This option is only available for airborne data and is checked by

default. This option can resolve the issue of power line data coloring where the color of the

power tower is assigned to the ground.

No Filtering of Tower Shadows (Left) Filtering of Tower Shadows (Right):

8.3.5 Output Settings

Depth Images: This function is only available in vehicle mode and is unchecked by
default. The depth map is obtained by processing panoramic photos and point clouds
simultaneously. When this option is checked, it must be ensured that both Point Cloud
Processing and Picture Processing are checked or have been completed.

Point Cloud Format: Currently, there is only one option, codata, which cannot be
changed. The codata point cloud is used for display and browsing.
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8.3.6 Automatically Load Point Cloud After Data Processing

By default, this option is unchecked. When checked, a prompt will appear after Data
Solving is complete, asking whether to load the data. Clicking confirm will automatically load
and display the data trajectory and point cloud.

8.3.7 Generate Result Report

Generate Results Report：when generating the results, a result report will be generated.

The result report includes four parts: project summary, process overview, picture
overview and point cloud overview. The result report is as follows:
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8.3.8 Other Settings

Batch settings: this function can set all projects to a set of same parameters.
Output directory: default path is Results folder and user can configure it.



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 134

8.3.9 View Result

Description
After process finished, user view Codata format point cloud data in CoPre 2.
Steps
 Select target node then click “Trajectory – ” to load mission. Click on two points

or hold left button to select trajectory, then the relative point cloud data will be
displayed.

8.4 Strip Adjust

Description
The Strip Adjust function mainly addresses the issue of data misalignment and improves data
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accuracy; the software supports airborne Strip Adjust and vehicle-mounted Strip Adjust.

8.4.1 Airborne Strip Adjust

Steps
 Perform data processing on the original project data to generate processing nodes;
 Click on Toolbar -> Processing- > Strip Adjust (or right-click to select Strip Adjust), and

the Strip Adjust interface will pop up;
 In Step 1, select the project and check the project data that needs Strip Adjust;
Note: Only data of the same carrier type can be adjusted; data of different carrier types
cannot proceed to the next step.

 In Step 2, set the airborne Strip Adjust parameters. After setting, click Start to begin
the Strip Adjust process.
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Block size: Process the point cloud according to the block size, generally the default
parameters are sufficient;

Grid size: Sampling the point cloud, mainly used to speed up the Strip Adjust process; if
the value is too large, it may lead to a decrease in Strip Adjust accuracy.

Note: This parameter will not affect the sampling of the adjusted point cloud results,
only impacting the speed and accuracy of the Strip Adjust;

Strip Adjust mode: The Strip Adjust will modify the original POST, with two
modification modes: Change Attitude or Change Position And Attitude. If the POST position is
known to be very accurate, you can choose to change attitude; if both are uncertain, you can
choose to change position and attitude;

Multi-project Strip Adjust: This option will only be available when multiple projects are
selected. If checked, the data from multiple projects will be adjusted together; if unchecked,
each project will be adjusted separately.

 After the Strip Adjust is completed, an accuracy report will pop up, and the adjusted
POS, point cloud, and log files will be generated in the corresponding project under
the ADJUST folder in the task path.

 Right-click on the Strip Adjust node to view the accuracy report; If you need to save
the accuracy report, click the 'Export' button at the bottom left of the Strip Adjust
report to export it.
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 After the Strip Adjust is completed, a corresponding Strip Adjust node will be
generated under the results project, and users can load the adjusted point cloud for
viewing. For detailed operations, please refer to the section '8.3.8 View Result' of
this document.

8.4.2 Vehicle adjustment

Steps
 Solve the Raw project (vehicle data) to generate result nodes；
 Click“Processing-> Strip Adjustment”（Or right-click the result node and select "Strip

Adjustment"），The strip adjustment interface pops up；
 In step 1 "Select Project", check the project data that needs to be adjusted;
Note: Only data with the same carrier type can be adjusted. If the carrier types are
different, you cannot proceed to the next step.



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 138

 In step 2, set the vehicle-mounted adjustment parameters. After setting, click "Start"
to start the adjustment process.

Note: If multiple projects are checked at the same time in the adjustment interface,
adjustment will be performed between multiple projects!

Parameter settings：
Automatic adjustment：Without manual intervention, Link is automatically generated,

and then trajectory optimization is performed based on the error value provided by Link. If
the stratification effect after fully automatic adjustment does not meet expectations, you can
continue to manually edit the Link based on the fully automatic adjustment, and then
globally optimize and generate results, or you can directly choose to use the semi-automatic
adjustment function.

Semi-automatic adjustment：It is generally used in scenarios that cannot be solved by
automatic adjustment and require manual intervention. Manual adjustments can be made to
locations with large stratification based on the error values provided by the Link. Links can
also be regenerated and manually inserted until the estimated stratification effect reaches
the expected level. Global optimization can then be performed to generate results.

Selected time period area adjustment：Adjust the point cloud data corresponding to
the selected trajectory area, and display the result trajectory and select it;

Use Control Points：During the adjustment process, GCP data is used to optimize the
absolute accuracy of the point cloud. It is necessary to import control points in advance and
select corresponding matching points in the result project. For detailed operations, refer to
this document "7.7 Control Point Check";
 After the adjustment is completed, the accuracy report of the adjustment will pop

up, and the adjusted POS, point cloud and log files will be generated in the project
corresponding to the ADJUST folder under the task path;
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 After the adjustment is completed, the corresponding adjustment node will be
generated under the result project, and the user can load the adjusted point cloud
for viewing. For detailed operations, please refer to the "7.4.8 Results Browsing"
section of this document.

8.5 Link List
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8.5.1 Regenerate

Description
Users can customize Link generation parameters to re-detect and generate Links.
Steps
 After the Link list is generated, click the "Regenerate" button to pop up the Link

detection settings window;

 After selecting the corresponding parameters, click "Confirm" to regenerate the Link.
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Parameter settings：
All Solved Areas：Generate Links based on all solution areas.
Displayed Areas：Generates links based on the area displayed in the 3D view.
Detection Radius：The maximum radius of the adjacent flight zone to search when

generating a link.
Detection Spacing：The distance between links (along the track direction).
Delete Links For The Whole Project：Delete all existing Links in the current project and

regenerate.
Append To Current Links：Keep the Link of the current project and append the newly

generated Link to the Link list.

8.5.2 Manual Insertion

Description
The user can manually select a location on the 3D view according to the actual layering of
the point cloud, and the algorithm will automatically calculate and insert the Link based on
the selected point location.
Steps
 Click the "Manual Insert" button, and the message "Start Manual Insert!" will be

displayed;

 Use "Ctrl+left mouse button" to select a point at the overlapping position of the
point cloud. After selecting, a prompt box "Do you want to insert a link here?" will
pop up. Click "OK" to insert the link;

 The message "Manual insertion successful!" is output and the manually inserted link
is added to the Link list.
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8.5.3 Link List

8.5.3.1 Estimation Error

Overall error before optimization：Displays the estimated point cloud error before
optimization.

Overall error after optimization ： Displays the estimated point cloud error after
adjustment.

Note: Error accuracy is affected by the data environment and may be inaccurate in
areas where point cloud features are not obvious.

8.5.3.2 Sorting a list of Link

Description
Sort the contents of the Link list in ascending order.
Steps

 Click the header in the list The links can be

sorted in ascending or descending order by "Link Number", "Current Error" or
"Estimated Error".

8.5.3.3 Link Accuracy

Description
The Link accuracy is described according to the legend. “Good”means the misalignment of
point cloud is the value range that meets the green legend setting； “poor” means the
misalignment of point cloud is the value range that meets the poor legend setting.
Steps

 Click“ ” The Link accuracy legend range can be edited.
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8.5.3.4 Link Location

Description
The Link is centered in the view.
Steps
 Double-click a Link in the Link list or right-click a Link and select "Locate". The 3D

view will jump to the corresponding position of the Link and highlight it.

8.5.3.5 Link Edit

Description
When the Link estimation error does not meet expectations, the Link can be adjusted to
optimize the adjustment effect.
Steps
 Right-click a link in the Link list or view and select Edit. The Link editing page pops

up.
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 You can view the top view and side view of the two point clouds where the Link is
located after estimation and optimization. The red one is the fixed Link and the blue
one is the unfixed Link.

 Open“ ”Button，Drag the point cloud until the point clouds at the same position
overlap. Click“ ” The Link can be restored to its original state.

8.5.3.6 Link Delete

Description
In general, it is better to remove invalid Link or Link that cannot be edited to overlap two
point clouds.
Steps
 Right-click Link and select "Delete".



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 145

8.5.3.7 Global Optimization

Description
Optimize the entire area by using Link's offset.

Steps
 Click the "Global Optimization" button to perfo·rm global optimization manually. A

global optimization progress bar will appear below the button. Semi-automatic
adjustment requires manual global optimization, while fully automatic adjustment
does not require manual global optimization.

8.5.3.8 Generate results

Description
Apply the globally optimized parameters to generate results.

Steps
 Click the "Generate Results" button to manually generate results. A progress bar will

appear below the button. Semi-automatic adjustment requires manual generation of
results, while fully automatic adjustment does not require manual generation of
results.

 After the results are generated, an adjustment node will be generated, and the
adjustment point cloud can be viewed.
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8.6 GCP Check

This chapter describes operations related to the control point window. It includes importing
control points, selecting matching points, checking control points and other operations.

8.6.1 Import GCP

User can import GCP under raw project node, pretreatment node and result node. GCP can
be used to refine trajectory or test absolute accuracy finally.

8.6.1.1 Import by control point file

CoPre 2 supports txt or csv formats file import, and make sure each line is kept
corresponding. Both NEH and BLH (degree.degree & degree, minute, second) format can be
read.
Steps
 Click the "GCP Check" button to activate the control points window;

 Click "GCP check-> Import GCP" to select the control points file in .txt or .csv format;

 After import, use “Separator” to divide contents. Make sure the column number is
corresponded to their contents (Name, E, N, H etc).
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Parameter descriptions:
Coordinate System Types: Includes WGS84, Local, and RTCM coordinate systems. WGS84
supports only BLH (latitude, longitude, height) and XYZ (Cartesian) coordinate inputs. The
Local coordinate system refers to the one configured during project creation. The RTCM
coordinate system is defined by the .crd file located in the GPS\CRS directory of RTCM data.
Notes:
① Only SLAM data currently supports the RTCM coordinate system.
② RTCM data and conventional SLAM data cannot be imported into the same task. RTCM
coordinate system selection is available exclusively for RTCM task control point imports and
requires compatibility with SmartGo version 1.3.2.4.

 Click “OK” to import GCP.
 After import successfully, both trajectory & point cloud interface will display

imported GCP data.

Notes
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If the control point file has update, support repeat import and it will cover old same name
points.

8.6.1.2 New GCP

Description
This function cannot be used on raw project node. Need select new GCP on point cloud. This
function is mainly used for two-way road data, and user can choose one side high accuracy
data as control points to calibrate another side. When use such function, make sure both
two-way scanning data contain this new GCP.

Steps
 Load solved project’s trajectory and point cloud data first, then click “GCP window -

Add GCP” on right side.
 Activate “Select” function and press “Ctrl” button, then click left mouse to select

point (Or Shift button with left mouse to select two lines for fitting). The coordinate
will automatically appear after selected, finally click confirm and it will present as
yellow color.

8.6.2 Select Matching points

The selection of matching points is to select points on the point cloud and match them with
control points. Before the operation of correction and result accuracy verification, the
selection of matching points should be carried out first. Elevation matching points can be
automatically added using elevation matching points, while plane matching points and
three-dimensional matching points need to be manually added.
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8.6.2.1 Import paired point manually

Activate “Select” function, then select paired point on interface: Press “Ctrl” button and left
mouse or “Shift” button and left mouse to draw 2 lines for fit, or “Alt” button and left mouse
three time to draw a circle center point , then press “Crtl” button with right mouse to input
relative control point name and refine type, finally click confirm. The paired point display as
blue color.

8.6.2.2 Height Matching

Height point matching is an automated process and no need to select point manually. But
this function is only suitable for height points matching (This function is mainly useful for
highway data).

8.6.2.3 Point Type / Correction Type Settings

 Set point type: User can set points as check point and generate accuracy report. The
interval between two neighbor check points is about 100-150 m.
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8.6.3 Check Control Point

This section describes how to use the imported control points to check the annotated check
list, including using the control point photo to check, checking matching points and
controlling point-to-point information.

8.6.3.1 Display GCP Pictures

Description
This function cannot be used on raw project node. User can easily select paired point based
on GCP pictures.

Steps
 First, named pictures as GCP name and save all pictures under one folder.
 Click “Display GCP picture” and choose picture folder path to import. Import GCP

name and display relative pictures. Roll mouse wheel can zoom in or zoom out
pictures.
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Notes
If add new pictures, need re-import path to view the new pictures.

8.6.3.2 Check Paired Point

Description
This function is used for control points and paired points checking. If neighboring control
point interval exceed threshold (default 100 m), then it will be considered as abnormal
control point and display as red color; if neighboring paired point error exceed threshold
(default 0.05 m), then it will be considered as abnormal paired point and display as orange
color.

Steps
 Click “Matched Point Check” on GCP window. When process is done, a report will be

automatically generated.
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 User can also click “Chart” to view the linear chart of result. If it contains wave peak
or wave valley, it might be the large error point and need to check whether need
re-select point for matching.

8.6.4 Control Point Other Functions

 Search control point: CoPre 2 supports search function if there are multiple GCP
contained.

 Copy control point: select one control point on the list, then right click copy. A new
copy point will be added with “copy” suffix.
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 Delete control point: select one control point or multiple control points from the list
(Ctrl+left mouse for multiple operation, Ctrl+A for all selection). Right click delete.

 Delete paired point: select one or multiple paired control points from the list
(Ctrl+left mouse for multiple operation, Ctrl+A for all selection).

 Trace control point: this function can quickly locate to target control point and zoom
on.
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 Show only the control points within the current POS range

8.7 GCP Adjust

Description
Refinement can reduce the error in a certain range and improve the absolute accuracy of
point cloud.

Steps
 Process the original project in the workspace node and generate the results in the

resultworkspace node.
 Import control points and select matching points on results or adjustment nodes.
 Right-click project name in the resultworkspace node and select “GCP Adjust” or

click “Processing”→”GCP Adjust” in the main view.
 Set refinement parameters.

 Mode 1: Just refine position only, will reprocess pos, used for data that does not
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require high accuracy of attitude.
 Distance Threshold (m) : If the distance between control points is less than the set

threshold, then the pos position refinement value is calculated according to the
adjacent control points.During refinement, the point clouds between the selected
points will be refined, and the point clouds within the smooth threshold before and
after the selected points will be smoothed.

 Smooth Threshold (m): If the distance between control points is more than the set
threshold, the data will be smoothed.

 Mode 2: Refine point cloud (base on near control point error),the point cloud
refinement value is calculated by interpolating the error of adjacent control points.

 Mode 3: Refine point cloud (point cloud overall offset), the whole point cloud is
rotated and offset.

Note:
When choose different refinement mode, the algorithm schematic diagram and
recommended usage scenario are displayed in the software window. Users can choose
the refinement mode according to the actual situation of the data.

 Click “OK”, CoPre will do the refinement automatically, and generate the results in
the resultworkspace node after refinement is completed.

 If user selects checkpoint when selecting control points in the result or adjustment
node, will generate accuracy report after refinement. Right-click the refinement
node to check the report.
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8.8 Export Results

Description
Can export point clouds, photos and colored point clouds in the result, adjustment,
refinement nodes.
Steps

 Process the original project in the workspace node and generate the results in the
resultworkspace node.

 Right-click project name in the resultworkspace node and do adjustment or
refinement.

 Right-click the result, adjustment, or refinement nodes to select “Export Results” or
click “Processing”→”Export” in the main view.

 Select to output point clouds , images or both, set the output directory, and click
“OK”.
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Right-click the project node to open the path for exporting results.

 Export by Project: Export point cloud files for each individual project.
 Merge Export: Merge selected projects into one single point cloud file; supports LAS

and LAZ formats.
 Coordinate Type: Can select projected coordinate system, geodetic coordinate

system, space rectangular coordinate system, topocentric coordinate system.
 File Format: Can output point cloud in las, laz, e57, pts, rcp format.
 Version: For point clouds in las and laz formats, there are versions 1.2, 1.3, and 1.4;

There is only one version in e57 and pts format.
 Color Range: You can set it to 0-255 or 0-65535; different software supports

different ranges, adjust as needed;
Including panoramic images: This option will only be displayed if the panoramic
image data has been processed and the export format is e57. The exported e57
point cloud contains panoramic image data, allowing simultaneous browsing of both
the point cloud and images.
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 Sampling Distance: Samples panoramic photos when exporting data that includes
panoramic images.

 Segment mode: The vehicle-mounted/packaged default is to segment by distance,
while the UAV airborne default is to segment by trajectory;

 File size: The exported results are segmented according to the set file size;
Note: The maximum supported size for a single file is 136GB.

 Distance: The exported results will be segmented according to the set trajectory
distance;

 Trajectory: The exported results will be segmented according to the set time period;
 Export range: Select all solved data by default. If only parts of point cloud are

displayed, select "displayed data" to export only the data that has been displayed;
 Camera: Export pictures and camera POS.
 Output Directory: The default output directory is...Results\Export folder, user can

also change the path.Right-click the project node can open the path for exporting
results.

8.9 Pause & Cancel

During data process, user can pause or cancel the processing step. After pause, user can click
continue to keep start work.



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 159

9 SLAM Processing

This section includes Loading Real-Time Data, Exporting Real-Time Data, Optimize Data,
View Report, Export, Cancel, Registration, GCP Check, GCP Adjust, and Modeling functions,
as shown in the figure below

9.1 Load Real-Time Data

Description

The original data of SLAM contains the real-time point cloud data output during the
collection. This function can load the real-time point cloud into the 3D view for display and
cutting, measurement, etc.

Steps

 Under the task management window, select the one or more raw project nodes to
be processed, and click "SLAM Processing-> Load Real-Time Data" (you can also
right-click to load the real-time SLAM data on the raw project node).

9.2 Export Real-Time Data

Description
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Export of real-time point cloud in .las format via raw project.

Steps

 Click "Main View-> SLAM Processing-> Export the Real-Time Data" (you can also
right-click to export the real-time point cloud on the original engineering node);

 Set export parameters, including las version number, whether to segment, and
segment size, then click OK.

 After the export is complete, the export results are listed in the raw project SLAM _
DATA / RealTime_las directory.

9.3 Optimize Accuracy

Description

This function is divided into three steps: Select Project, SLAM Trajectory Optimization,
Result Settings, After setting the parameters, proceed with the calculation to generate
the point cloud. The file is saved in the Results folder under the task.

Steps

 Click "Main View-> SLAM Processing-> Optimize Accuracy" (you can also right-click
the SLAM Processing on the raw project node);



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 161

 Optimize Accuracy dialog box appears, In "Step 1: Select Project," check the project
that needs to be processed, and then click "Next";

 Enter the "Step 2 GNSS Trajectory Optimization", select the solving mode, set TGCP,
and configure the solving scenario for each project;
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Solving Mode:

(1) Select Default (available for RS7 data only). The system automatically uses the
solving mode (SLAM or RTK) selected during data acquisition.

（2）Choose RTK POS Optimization, if the real-time RTK is valid, the point cloud will be
solved using the real-time RTK, and if the real-time RTK is invalid, the one-click refinement
will be solved in pure SLAMmode. Click Next.

（3）Choose to use PPK POS Optimization , and the POS solution will be performed by
one-click refinement, if the PosT has more floating-point solutions, the pure SLAMmode will
be used, and if the PosT has more fixed solutions, the point cloud will be solved by PosT
post-processing.

Select to use the Field Base Station：

If the Field base station data is already available in the project file, the base station data will
automatically load and display (see Section 7.2 for this function description), and click Next;
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Note: The RS10 data does not haveloosely coupled or tightly coupled processing modes,
accel/gyros scale and atmospheric estimation settings , and can not generate POS reports.

Parameter declaration:

Remove: remove the cloud base station or Field base station. After removing the cloud
base station, the cloud base station will be downloaded again for calculation;

Add: add the Field base station data;

More: Show or hide ephemeris data, including GPS, BEIDOU, GLONASS, GALILEO, QZSS,
check the first 4 by default;

（3）If you choose to use Only SLAM solving, you will not use real-time RTK and PosT for
one-click refinement.

Apply to other projects: base station type of the current project, cloud base station
download Settings, and ephemeris settings will apply to other projects;

Use TGCP for Trajectory Optimization: Select whether to optimize the trajectory using
control points for each project;

（1）Select not to use the TGCP Trajectory Optimization, and the control point will not
be used to optimize the trajectory accuracy, click Next;

（2）Select to use the TGCP Trajectory Optimization, and enter the trajectory control
point setting, when the real-time point of the project is in the unmatched state, showing red;
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Steps

1) Click "Import" to select the control point file in .txt or .csv format;

2) In the import control point window, set relevant parameters, then click OK to import
the control points, and then click "Next";

Tip:The parameter descriptions in the imported TGCP settings can be found in Section 8.6.1.
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3)The point type can be set to refine point or check point. At least 4 refine points are
required to optimize the trajectory. After GCP optimization, it will automatically generate
refine report and check report.

When the control point file is imported, all control points will be automatically matched in
the project list, and the matching information will be automatically recorded in the matching
file. The number of successful real-time point matches will be displayed behind the project
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name. The successfully matched real-time points will be green, and the unmatched real-time
points will be red. Matching successful real-time points can be checked to use, this function
is applied in the trajectory control point optimization function in SLAM solution.

Parameter declaration:

Matched: The live point that successfully matches the control point appears green.

Not found: The live point that failed to match the control points appear red.

Output Reports: Output reports after TGCP adjust ， with refine points report as
SLAM_Refine_Report.csv, and check points report as SLAM_Check_Report.csv

Import: import external control points, support multiple additional import control point files.

Clear: Clear all imported control points.

Calculated residual: Evaluate whether the trajectory control points can be used for control
point optimization, and if the residuals are too large, you can leave the corresponding
real-time points unchecked, so as not to affect the solution accuracy.

Display to point cloud view: you can load the real-time point cloud, real-time points, and
imported trajectory control points of the current selected project in the 3D view.

OK: Save the track control point interface settings.

Note: If there is TGCP in the raw project, it can export TGCP file after accuracy
optimization. TGCP.txt file will be saved in the directory of processing project, TGCP Report
folder.

Note: The trajectory control point is matched according to the name. Change the name
of the corresponding control point carefully before importing the trajectory control point. If
the TGCP Trajectory Optimization function is required for SLAM processing, the pair of
trajectory control points checked must be greater than or equal to 4 refine points.

Scene Settings (for RS10 data):

Five scene options: Indoor-Outdoor Fusion, Indoor, Outdoor, Tunnel, and Open Area. Select
according to the actual data scenario.

Advanced Settings (for RS7 data):

Set processing templates, including Auto, Indoor, Outdoor, Narrow Space, and Custom. When
Custom is selected, parameters can be adjusted.

 Enter Step 3 "Result Settings", set the processing parameters, click Start, the
progress bar appears in the raw project node, the processing node is generated, click
the processing project right menu to display the trajectory, box select the trajectory,
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and the image and point cloud can be loaded in the 3D view.

Parameter declaration:

Coloring: There are three modes: Fast Coloring, High-Precision Coloring and uncoloring, use
image data to color point cloud, showing uncolored point cloud in white.

Fast coloring: Fast efficiency, average effect, used for scenes with low coloring requirements.

High-Precision Coloring: Slow efficiency and good results, suitable for scenes with high

coloring requirements. This mode must be equipped with a NVIDIA graphics card,
recommended configuration: 3050Ti series and above graphics card, Intel Core i7 and above
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CPU.

Panoramic Images： If you check Use panoramic image coloring, panoramic image coloring
will be used, otherwise built-in camera coloring will be used. In most scenes, panoramic
image coloring will have better results.

Tip: For Insta360 data, the built-in camera is used for coloring if Panoramic Camera Coloring
is unchecked; the panoramic camera is used for coloring if checked.

If unchecked: Outputs POS data for the built-in camera images, including position, attitude,
and time. It can be overlaid with the point cloud and used for modeling in third-party
software.

If checked: Outputs POS data for Insta360 images, including position, attitude, and time. It
can be overlaid with the point cloud.

Note: To use this function, please download the Insta360 resource pack via About →
Resource Pack → Resource Pack Downloader.

Modeling

Construct 3D models using image and point cloud data, including Mesh Modeling and 3D
Gaussian Splatting (3DGS).

Mesh Modeling

If Use Panoramic Photos is checked, modeling uses panoramic images; otherwise, it uses the
built-in camera.

Panoramic image modeling delivers better results in most scenarios.

3D Gaussian Splatting (3DGS)

Requires processing with Insta360 panoramic images.

After 3DGS is completed, the model can be loaded and viewed in the 3D Gaussian view.

Compared with traditional Mesh modeling, 3DGS provides more realistic visual effects but
takes longer processing time.
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Advanced Settings - RS10

Advanced Settings – RS7

Point Cloud Optimization: Reduces point cloud thickness and refines local details for finer
display.

Moving Object Filter: Filters out moving people and objects from the point cloud.

Point Cloud Denoise: Removes floating noise points attached to the point cloud surface to
improve overall quality.
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Delete Unshaded Points: Removes all uncolored points.

AI Human Filter: Filters out all human-shaped points; may cause partial point cloud holes.
This function requires downloading the corresponding resource pack via the Resource Pack
Downloader.

Multiple Return: Outputs multi-echo point cloud when checked; outputs single-echo point
cloud when unchecked.

Sampling Rate: The sampling rate can be set via the dropdown menu during result
generation, with options: 25%, 50%, 75%, 100%. The default sampling rate is 100% (no
downsampling).

Output Settings: CoData format point cloud is always output during data solving. To output
LAS files, check the LAS option; corresponding LAS files will be generated in the result
output.

Automatically Load Point Cloud After Data Processing: Once the solution is complete, the
point cloud can be loaded automatically.

Generate results report：Output SLAM accuracy report. For detailed description of report
parameters, see "9.4 View Report" in this document.

3D Distance Filter: For parameter details, see 8.3.4.6 Advanced Settings in this document.

Intensity Filter: For parameter details, see 8.3.4.6 Advanced Settings in this document.

Tip: To output insta360 image POS, you need to manually copy the .insv image file to the
original data Camera4 folder.
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9.4 View Report

Description

Output the parameter information and data accuracy information used by SLAM one-click
refinement.

Steps

 In the task management window, select the result engineering node that needs to be
processed, click "SLAM Processing->View Report" or right-click the result engineering
node and click "View Report".

The SLAM results report includes data solution parameters, data accuracy overview and
GNSS quality.

Solving Parameters ： Contains one-click refined calculation parameters and computer
hardware parameters;

Data Accuracy Overview：Contains main accuracy information table and trajectory relative
error;

GNSS quality：Includes PPK data quality and GNSS quality rendering effects.
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Solving Parameters：

Data Accuracy Overview：

GNSS quality：
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9.5 Convert Format

Description:

The coordinate systems for results projects are divided into relative coordinate systems
and projection coordinate systems. Therefore, the format conversion function corresponding
to the results project is also divided into two types, which can convert the results project
point cloud into other types or formats of point clouds.

Steps:

 Select one or more processing project nodes under the task management window,
and click "SLAM Processing-> Export" (you can also right-click convert format on the
project node);
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 Through the previous step, enter the format conversion setting window, set the
Coordinate type, File Format and Version, Segment Mode, Export Range and Output
Directory, and then click OK;

Tip: When the selected project is the relative coordinate system, the result export does not

involve the conversion of coordinate type, but a simple file format and version conversion;

when the selected project is the projection coordinate system, the result export supports

coordinate type and file format and version conversion.

Parameter description:

Use RTCM Coordinate: Exports results in the RTCM coordinate system.

Note: RTCM data and standard SLAM data cannot be imported into the same task. This
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parameter is available only for RTCM data exports and requires SmartGo version 1.3.2.4.

The parameters are detailed in Section 8.8.

 After the export is completed, you can view the exported image and point cloud, and
the export path is under the task by default... Results\Export folder, users can also
customize the path.

9.6 Cancel

During the SLAM processing, you can cancel the process. The cancellation will end the

current data processing operation.

9.7 GCP Check

Hide / display the control point window. Supporting real time point cloud and processed
point cloud to check accuracy.

9.7.1 Automatically match control points

Description

The points collected by SLAM in real time are automatically matched with the
externally imported control points.

Steps

 Load real-time point cloud or engineering point cloud;
 After clicking "Auto Match", the automatic matching window pops up. After clicking

"Confirm", the points collected in real time will be used as matching points to match
the externally imported control points.
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9.8 GCP Adjust

Description

The function of GCP adjustment is to reduce the error within a certain range and improve the
absolute accuracy of the data. Before adjustment, you must import control points, select
matching points, set refine types, etc.
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Steps

 Import control points and select matching points on the processing project nodes
after you have processed the project;

 Select the processing project node, click "Main View->SLAM Processing->GCP Adjust,
(or right-click and select "GCP Adjust")

 Enter adjustment interface, you can set whether the control point participates in the
adjustment by modifying the point type. Software can automatically calculate the
residual, then you can click "Ok" after the setting is completed;

 After the adjustment is completed, refine points report and check points report will
be generated and saved in the refine project.
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9.9 Mesh Modeling

Description

Build 3D models using built-in camera images and point cloud data.

Steps

 Click "SLAMModeling->Mesh Modeling" (You can also right-click on the achievement
project node or adjust node,then click "Mesh Modeling");

 Select the project that needs to be modeled and click "Process";
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 After the Mesh modeling is completed, a model node will be generated. Right-click
the model node to load the model in the 3D view.
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Parameter description:

Modeling Mode: Compared with Normal Mode, the model built in High-Quality Mode is
more refined but takes longer processing time.

Left: High Quality Mode Right: Normal Mode

Modeling with a panoramic camera： If you check the "Use panoramic image modeling"

option, the panoramic image modeling will be used, otherwise the built-in camera modeling

will be used. In most scenarios, the panoramic image modeling will have a better effect.

Automatically load the model after data processing: The model will be automatically loaded
after modeling is successful.

Multi-Project Fusion Modeling: After selecting multiple projects, you can check the option
for multi-project fusion modeling; the software will combine the selected project data to
construct a complete model. The current version only supports built-in camera data for
fusion modeling；

Fusion modeling project name: When selecting multi-project fusion modeling, you can set
the name of the modeled project.

Tips:

1. Modeling can only be used after enabling modeling permissions for RS10/RS7 devices in
the SmartGo software.

2. For RS7 data, SmartGo version 1.5.3 or later and firmware version 1.2.11 or later are
required

3. Modeling permissions for RS10 16 lines/32lines devices must be enabled in the SmartGo
software before you can use modeling;
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4. SLAM modeling must be equipped with an NVIDIA graphics card, recommended
configuration: 3050Ti series or higher graphics card, Intel Core i7 or higher CPU, and 32GB or
more systemmemory;

5. Modeling takes a long time, please be patient;

6. Modeling occupies a large amount of disk space, please ensure there is sufficient disk
space;

7. When using multi-project fusion modeling, please ensure there are overlapping areas
between projects.

9.10 3DGS Modeling

9.10.1 Software configuration requirements

Hardware Environment：

3DGS modeling function requires the computer to use an NVIDIA graphics card.

The recommended configuration is: 4090 series graphics card, video memory 24G and above,
memory 64G.

Minimum Requirements：12G video memory, GeForce RTX 3080, 32G memory.

Supported graphics card types: GeForce RTX 3080, GeForce RTX 3080 Ti, GeForce RTX 3090,
GeForce RTX 3090 Ti, GeForce RTX 4060 Ti, GeForce RTX 4070, GeForce RTX 4070 SUPER,
GeForce RTX 4070 Ti, GeForce RTX 4070 Ti SUPER, GeForce RTX 4080, GeForce RTX 4080
SUPER, GeForce RTX 4090 D, A4000, A100, and NVIDIA RTX for some workstations.

Software Environment：

You need to download the 3D Gaussian modeling resource package through the
"About->Resource Package->Resource Package Downloader" function.

9.10.2 Data requirements

1. SmartGo version requires 1.4.1.2 and above, and firmware version requires 1.7.2 and
above. You need to enable the 3D Gaussian modeling permission of the RS10-RS series
device in SmartGo software before you can use 3D Gaussian modeling.

2. RS7 data requires SmartGo version 1.5.3 or later and firmware version 1.2.11 or later. 3D
Gaussian modeling can only be used after 3D Gaussian modeling permission for SLAM
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devices is enabled in the SmartGo software.

3. 3D Gaussian modeling is only supported for external panoramic cameras in video mode:
Insta360 X4, Insta360 X5. And RS7 data captured in 3DGS Capture Mode on the SmartGo
acquisition.
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4. 3D Gaussian modeling requires an NVIDIA graphics card. Recommended configuration:
4090 series graphics card, video memory 24G or more, systemmemory 64G or more.

5. 3D Gaussian modeling requires one-click precision calculation of insta360 panoramic
images.

6. The recommended data collection time is about 30 minutes.

9.10.3 3DGS Modeling

Description

The model is generated by fusing SLAM point cloud data and insta360 image data, and only
the model output in .ply format is supported. Compared with Mesh modeling, 3DGS is more
realistic in visual effects, but it takes longer.

Steps

 Click "SLAMModeling->3D Gaussian Modeling" (You can also right-click on the
achievement project node or adjust node, then click "Gaussian Modeling");

 Select the project that needs to be modeled and click "Process";
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 After 3D Gaussian modeling is completed, a model node will be generated.
Right-click the model node to load the model in the 3D view.
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Parameter Description：

Automatically load the model after data processing：After the modeling is successful,

the model will be automatically loaded in the 3D Gaussian view.

Tips：

1. Modeling takes a long time, please be patient;

2. Modeling takes up a lot of disk space, so make sure there is enough disk space;

3. Modeling takes up a lot of GPU resources, so please do not run other software at the

same time.
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9.11 Registration

9.11.1 Configuration requirements of the software

Multi-station splicing requires the computer to use NVIDIA graphics card, recommended
configuration of 3050Ti, and above, memory 32GB and above.

graphics card Settings:

Right-click on the desktop, select the NVIDIA Control Panel, click Manage 3D Settings->
Global Settings-> Set the Preferred graphics processor to a high-performance NVIDA
processor, and then select a separate graphics card in the OpenGL Render GPU column.

9.11.2 Unified Coordinate System

Multi-site match can stitch the results of local coordinate system and projection coordinate
system.

When the projects selected are not in the same coordinate system, the following window
will pop up when entering multi-site match:
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First, select a reference project on the left and display it at "Current Project". The software
will calculate the distance between other projects and reference point. Among them, the
projects whose distance from "Current Project" exceeds the set "Distance Threshold" will be
marked in red.

Click "OK" to unify the red-marked projects to the same coordinate system as "Current
Project", which is convenient for subsequent manual and automatic stitching. Click "Cancel"
or close to exit this operation.
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9.11.3 Interplane introduction

1．The project list management interplane to control the status of the point cloud
corresponding to the current project;

2．Point cloud transformation operation interplane to rotate the selected point cloud in the
active view;

3．Crop operation interplane, control the crop plane state corresponding to the three views;

4．Main view, support browsing point cloud, including RGB, elevation, intensity rendering,
support opening crop operation;

5．Top view, support browsing point cloud under the top perspective, support the control of
the side view, support the keyboard "↑" "↓" key to move the crop plane;

6．Side view (east-> west), support browsing point cloud under the side view, support to
control the top view crop plane, support moving the point cloud on this view, support the
keyboard "↑" "↓" key to move the current top view crop plane;

7．Side view (north-> south), support browsing point cloud under the side view, support to
control the top view crop plane, support moving the point cloud on this view, support the
keyboard "↑" "↓" key to move the current top view crop plane;

9.11.4 Project List Management

The sidebar of the project list shows the current project state, which can control the
selection, display / hide, lock/unlock, color and location of point cloud. The project list
sidebar layout is as follows:
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Display / hide: used to control the display / hide of point cloud. When the point cloud is
hidden, the point cloud cannot be operated.

Color rendering: used to change the color of point cloud, click the color selection plane to
pop up, select the color and click confirm, the color of the point cloud will be modified.

Zoom: used to center display the current point cloud in the view.

Lock: used to lock the current point cloud. After locking, the point cloud cannot be

edited.

Others: The point cloud object can be selected by using the left mouse button in the three
views or by clicking the list item in the project list. The selected point cloud will be
highlighted, and the point cloud transformation operation will take effect on the selected
point cloud.

9.11.5 Crop setting

There are three directions of cropping planes in the software, namely the top view, side view
(east→west) and side view (north→south). The top view cropping plane is displayed in the
two side views, and the two side view cropping planes are displayed in the top view, as
shown in the figure below.

Use the cropping plane to crop the point cloud, and only the point cloud within the cropping
plane range will be displayed in the three views.

The point cloud clipped by the cropping plane with the default color of purple is displayed in
the top view, the point cloud clipped by the cropping plane with the default color of green is
displayed in the side view (north → south), and the point cloud clipped by the cropping
plane with the default color of blue is displayed in the side view (east → west). The
functions of the buttons in the main view are as follows (as shown in the figure above):
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Crop: click the button to turn on the crop plane. In the main view, hold down the Ctrl key
on the keyboard and press the left mouse button to select the center points of the three
cropping planes on the point cloud. After selection, the cropping planes are displayed in the
main view, and the cropping effect of the three views takes effect. Click the crop button
again, and the cropping planes are hidden in the main view.

Display / hide: used to control the display / hide of crop planes in three views. Where
the top view crop plane is shown in two side views and two side view crop planes are shown
in the main view.

Color rendering: used to change the color of the crop planes, click the color selection
plane, click to select the color confirmation, the crop plane color will be modified.

Zoom: used to center display the current point cloud in the view.

Crop setting: parameters to modify the crop planes, including the current thickness of

the crop plane and moving step. After clicking the crop setting, the setting page shown in the
following figure will appear:

The complete operation process is as follows:

1. Open the cropping plane in the main view;



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 191

2. Use the Ctrl + left mouse button to select the current crop center point in the main
view;
3. Control crop planes display / hiding, and crop settings;
4. Control crop planes in the three views to view the point cloud;

9.11.6 Crop plane operation in three views

The crop plane can be operated in the three views. The following figure shows the crop plane
of the side view (north → south) and the side view (east → west) in the top view and the
cropped "east → west" and "north → south" point cloud views.

Note: Change the position, thickness and direction of the top view cropping plane in the two
side views, and change the position, thickness and direction of the side view (east→west)
and side view (north→south) cropping planes in the top view.

When the top view cropping plane is changed in the side view, the real-time cropped point
cloud is synchronously updated in the top view. Similarly, when the side view (east→west) is
changed in the top view, the real-time cropped point cloud is synchronously updated in the
side view (east→west).
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The cropping plane is a rectangle in a two-dimensional image. The center of the rectangle is
the center of the view, and the direction from the outer circle to the center is the viewing
direction. When the cropping plane is moved and rotated, the corresponding cropped view
will move with the cropping plane, and the center of the cropped view will always be aligned
with the center of the cropping plane.

Basic operation:

1. Move the cropping plane: left click the cropping plane to highlight, and then drag the
cropping plane through the mouse;

2. Move the cropping plane: move along the vertical direction of the cropping plane, and
the upper and lower direction keys of the keyboard correspond to the front and rear
perspective direction of the cropping plane.

3. Rotate the cropping plane: in the current view, press Ctrl and left click to select the
cropping plane to highlight, drag the mouse around the center of the current view, and the
cropping plane will rotate along the direction of the mouse;

4. Modify the thickness of the cropping plane shortcut key: mouse click to a crop plane, the
crop frame highlighted, ctrl + mouse wheel slide up and down to modify the width of the
crop plane.

9.11.7 Point cloud transformation operation

The software can move the point cloud by using the left mouse button in three views, or by
clicking the point cloud transform button. The layout of the point-cloud transformation
sidebar is as follows:
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Shown above is the point cloud transformation sidebar.

1．Displays the current active view;

2．Point cloud rotation button. Click the rotation button, rotate left or right with the center
of the point cloud as the origin, and refresh other views synchronously;

3．Point cloud translation button. Click the translation button, and the point cloud shifts
with the value in the input plane. The value in the input plane range from 0.01 to 99.99 m.
The translation direction refers to the coordinate axis xyz in the view, and the other views are
refreshed synchronously after translation.

Move the point cloud shortcut key operation: use the left mouse button in the three views to
select the point cloud to move the current selected point cloud location. The complete
operation process is as follows:

1．Set up the crop plane in the view;

2. Display / hide the cropping plane in the setting to facilitate the transformation operation
of the point cloud;
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2. Lock or hide the point cloud that is not operated in the project list, select the point cloud
to be transformed, move the point cloud with the left mouse button in the three views, or
click the point cloud transform button to transform the point cloud.

3.After the point cloud transformation is completed, click the "Save" button to save the
current transformation operation to all the point clouds. The Reset button can reset all point
clouds to the last initialization state.

9.11.8 Rough check of match accuracy

After manually match the point cloud, you can use the measurement tool to roughly check
the match accuracy. If the accuracy requirements are met, click "Save" to save all current
point cloud states, then return to the CoPre main page, click "Data Convert", and save the
matched results in the corresponding output directory.

Rough check of accuracy operation steps:

1. Click the measurement button of the three views to activate the measurement
function. After activation, you cannot use the left mouse button to drag and move the point
cloud in the view.

2. Click two points on the view, and the distance between the two points is displayed in the
lower left corner of the view.

3. Click the measurement button again to turn off the measurement function.
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9.11.9 Automatic Optimization

After rough manual matching, you can use the automatic optimization function for fine
matching.

Notes: ① Before using automatic optimization, check the overlap and accuracy of the point
clouds between the projects to be matched. The automatic optimization effect is good only
when the overlap of the point clouds between the projects to be matched is greater than
30% and the manual matching accuracy is less than 10cm, otherwise the accuracy after
automatic optimization may deteriorate. ② When running automatic optimization, the
current point cloud state will be automatically saved. ③ Automatic optimization only
supports two-by-two matching. When matching multiple projects, you need to run
automatic optimization repeatedly.

Operation steps:

1. Click "Automatic Optimization" and select a reference project and a conversion project.
After optimization, the point cloud of the reference project will not change, and the
optimization results will be applied to the conversion project.

2. After the optimization is completed, check the optimization effect. If the requirements are
met, click "Automatic Optimization" again to automatically optimize the remaining reference
projects and conversion projects; if the requirements are not met, click "Reset" to return to
the state before optimization, use manual matching to make adjustments, and then
automatically optimize again.



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 196

10 Calibration

Calibration aims to reduce installation errors that occur during the production, assembly, and
actual installation of LiDAR products, as well as to confirm the internal parameters of the ca
mera.

The automatic calibration feature in CoPre can be used to correct the placement parameters
of the LiDAR and camera. When there are changes in the device parameters or the device ha
s not been calibrated, it is necessary to use the calibration function to calibrate the device.

10.1 Calibration precautions

10.1.1 Calibration equipment requirements

1.List of devices that support calibration:

The following combination format is "Device name: Device combination type":

Insta360 device (with RS10/RS30):
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Supported camera types: Insta360_X4, Insta360_X5, Insta360_ONE_RS

UAV:

AA15: AA15, AA15+C5, AA15+C30

AA10: AA10

AU20: AU20, AU20+C5, AU20+C30

AU1300: AU1300, AU1300+C5, AU1300+C30

CAR:

AU20: AU20+AP5, AU20+AP5-L, AU20+AP5-L(SLAM), AU20+C-Type, AU20+AP7 Single
head(Ladybug series), AU20+AP7 Dual head(Ladybug series)

AU1300: AU1300+AP5, AU1300+AP5-L, AU1300+AP5-L(SLAM), AU1300+C-Type

2.Computer requirements:

Graphics card: only supports NVIDA graphics card.

memory: minimum 16GB, recommended 32GB or above.

10.1.2 POS requirements

Insta360 device (with RS10/RS30):

Insta360 devices (with RS10/RS30) have no POS requirements during calibration.

Other devices:

Calibration requires POS to achieve a certain level of accuracy. If the deviation is large, it may
result in inaccurate results. The following are recommended POS indicators:

1.The total number of post-processing fusion satellites: ＞24

2.Post processing fusion Q-value ratio (Quality Factor Plot): ＞99%

3.Post processing fusion position accuracy: EAST ＜0.02 North ＜0.02 height ＜0.02

4.Post processing fusion pose accuracy: heading ＜ 1.2arcmin pitch＜ 0.48arcmin Roll＜
0.48arcmin

5.Post processing fusion forward and backward position accuracy EAST: EAST ＜0.02m North
＜0.02 height ＜0.02
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6.Post processing fusion forward and backward attitude accuracy heading: heading ＜

0.3arcmin pitch＜0.3arcmin Roll＜0.3arcmin

The above data can be viewed by right clicking on the original project and selecting POS
accuracy curve after the completion of project Pos calculation.

10.1.3 Calibration site requirements

Insta360 device (with RS10/RS30):

1.Requirements for calibration site

① When collecting data, the device should be placed on a stable platform, about 1.2 meters
above the ground, and collected statically for more than 90 seconds.

② During the collection process, try to avoid moving objects (such as pedestrians or moving
vehicles) to avoid affecting the accuracy of calibration parameters.

As shown in the following figure:

Other devices:

1.UAV requirements

Choose an urban area with houses and urban roads, with an open location (no obstruction,
no high-voltage lines, no sources of interference, and houses accounting for about 50% of
the entire survey area).
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2.Car requirements

①Capable of conducting device satellite search, and the number of satellites displayed is
greater than 18.

② Choose an urban area with houses and urban roads, preferably at intersections,
supporting surrounding areas, and a sufficiently long road distance.

3.Temporarily unsupported venues

UAV not supported: areas lacking features such as vegetation, water bodies, and fields
account for more than 50% of the measurement area
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Car not supported: only positions with back and forth or single trajectories, high buildings,
elevated buildings, trees and other obstructions, open environments without characteristic
information such as street lights, utility poles, and markings (such as rural intersections)

10.1.4 Calibration route requirements

Insta360 device (with RS10/RS30):

No route requirements.

Other devices:

1.UAV

Before and after data collection, it is necessary to remain stationary in an open position for 3
minutes, starting with the character "8", to ensure that each airstrip can scan the house as
much as possible.

Flight height: 150m

Speed: 7m/s

Laser overlap rate: ＞50%

Camera overlap rate: heading 80%, lateral 80%

Trajectory length: 300-500m for a single straight route.

Trajectory quantity: 3-6 horizontally and 3-6 vertically.

Examples of these routes are shown in the following figure:
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2.Car

Before data collection, it is necessary to remain stationary in an open position for 3 minutes.
Start running a straight line of 50 meters and then wrap around 8 characters. After data
collection is completed, wrap around 8 characters again and remain stationary in an open
position for 3 minutes

Speed: around 40km/h

Try not to stop at intersections, and there should be no interruptions or turns in the middle
of the zigzag route

Examples of these routes are shown in the following figure:
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10.1.5 Single Lens Calibrate Instruction

10.1.5.1 Calibration Equipment Requirement

AP7+AU20+Ladybug

10.1.5.2 Data Acquisition Requirement

1. Scene Selection: Choose an open intersection with clear marking lines (no
stratification within single- /dual- head data). Each camera must capture ground
marking lines (not necessarily simultaneously, but during straight driving).

2. Point Frequency: Maximum point frequency.
3. Weather: Sunny with sufficient illumination, but not overly strong light (morning

is preferred).
4. Vehicle Speed: No more than 10 m/s, 5 m/s recommended to ensure point cloud

density.
5. Camera Shutter: 0–1800 μs to ensure clear, non- blurry images.
6. Capture Interval: One photo every 3–5 meters.

10.1.5.3 Photo Selection Requirements

1. Photos must not be blurry, streaked, stained with watermarks, too dark, or
overexposed.

2. Photos selected for each camera shall contain as clear and abundant ground
feature lines as possible; such lines shall not be concentrated only in one area of
the photo.

3. Select photos taken during straight driving; do not use photos taken at turns.
4. Do not use photos captured when the acquisition vehicle is stationary (e.g.,

waiting at a red light), as POS may jump when stationary.
5. Minimize interference from other vehicles near the acquisition vehicle in the

photos.
6. Do not select the first few or last few photos (to avoid missing corresponding

point cloud data).
7. Corner points of marking lines shall be positioned near the center of the photo

as much as possible, not at the edges.
8. Prefer clear arrow marking lines over zebra crossings.
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10.1.5.4 Examples of Incorrect Photos

1. Photos must not be blurry or exhibit streaking (Photos where corners cannot be

manually selected cannot be resolved by algorithms either).

Blurred photos with streaks

Normal photo taken at the
same location

2. No water stains allowed in photos
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3. The markings in the photo must not be blurred.

4. Photos should not be too dark or have strong reflections.
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5. Do not choose photos with alternating light and shadow.

6. Avoid placing marker line corners at the edges of the photo.



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 206

7. The corners of the marker lines should not be positioned too close to the data collection

vehicle or surrounding vehicles.

10.1.5.5 Recommended Photos for Each Lens
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Lens Recommended Photos Notes

Lens1

 The marking lines shall
be numerous, clear,
and evenly distributed
across all areas of the
photo.

 Particular attention
shall be paid to
interference from the
vehicle head on the
marking lines (do not
be too close to the
corner points of the
marking lines).

Lens2
Arrow marking lines are
preferred.
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Lens3
Arrow marking lines are

preferred.

Lens4
Arrow marking lines are

preferred.
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Lens5

 When the arrow
marking lines are not
clearly distinguishable,
you may select a
clearly visible zebra
crossing whose corner
points are located in
the middle of the
photo.

 Particular attention:
photos must not be
taken in
curved/turning areas.

10.2 How to calibrate

Insta360 device (with RS10/RS30):

1.Load the raw project and data.

2.Click on the "Calibration" menu, then click on the calibration button.

3.Select the raw project to be calibrated in the pop-up interface, and Insta360 calibration
(with RS10/RS30) only supports camera calibration (uncalibrated devices will be checked by
default when the window is opened).

4.After all settings are completed, click confirm to start automatic calibration. The calibration
time is affected by the amount of data and usually lasts for 3 to 5 minutes or more.
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5.Waiting for the calibration process to end, a calibration node will be displayed in the
current task list, where you can view the calibration results.

Other devices:

1.Load the raw project and data.

2.Click on the "Calibration" menu, then click on the calibration button.

3.Select the raw project to be calibrated in the pop-up interface, and generally select all
calibration methods (the uncalibrated devices will be checked by default when opening the
window).

4.After all settings are completed, click confirm to start automatic calibration. The calibration
time is affected by the amount of data and usually lasts for 10 to 30 minutes or more.

5.Waiting for the calibration process to end, a calibration node will be displayed in the
current task list, where you can view the calibration results.
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Attention:

Under the current process, when calibrating a camera separately, it is necessary to ensure
that laser calibration has been completed, otherwise the accuracy of calibrating the camera
separately cannot be guaranteed.

10.3 How to save parameters

After the automatic calibration is completed, the calibrated parameters are saved in the
calibration project. After manual inspection and confirmation of good calibration results, the
calibration parameters can be updated to the original project using the "Apply Param" tool.

Steps:

1.Select the target calibration project, and then click the "Save Calibration Parameters"
button in the calibration menu.

2.Select the project to apply the parameters in the pop-up window.

3.After entering the calibrator, click Apply to save the calibrated laser and camera
parameters from the calibration project to the selected original project.

Attention:

The software will automatically recognize the data in the original project list and the
equipment SN of the selected calibration project, and automatically select projects with the
same SN.

If the calibration parameters currently used do not match the equipment of a certain project,
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the software will display a red prompt.

10.4 How to update device parameters

The update calibration parameter function can update the parameters from the raw project
to the device, usually used after saving the calibration parameters.

Steps:

1.Connect the device disk and click the "Update Parame" button in the calibration menu.

2.Select the parameter selection method in the pop-up window, and then select the raw
project from the disk based on the parameter reading method you have chosen. After
selection, the information of the currently selected project will be displayed at the top of the
interface.

3.Click the connect button, the software will connect to the device and display the current
device information.

4.Enter the calibrator and click Apply to update the parameters of the selected raw project
back to the device.

Attention:

Insta360 device (with RS10/RS30):

If using CP files for SLAM devices when selecting parameters, you need to find the CP files in
the Camera4 folder.

Other devices:
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If using EP and CP files when selecting parameters, you need to find the EP file in the
Scanner1 folder and the CP file in the Camera1 folder.

10.5 How to rollback the raw project calibration parameters

When updating the calibration parameters of the raw project, the software will record the
previous parameters locally. The calibration parameter fallback function can be used to view
the historical calibration parameters of a certain data.

If the current calibration parameters are not as effective as the previous parameters, the
software also supports using historical parameters to update the current calibration
parameters.

Steps:

1.Click the "Calibration Param Rollback" button in the calibration menu.

2.Select the project to be viewed from the list of projects on the left, and the information list
on the right will display the historical parameter information of the corresponding project, as
well as the corresponding calibration personnel, calibration time, etc.

3.Check one of the historical information, enter the operator information, and then click on
the update parameters in the bottom right corner of the interface.

4.The current laser parameters in the list will be modified to the selected information, and a
record will be added to the historical information. At the same time, the corresponding EP
and CP files of the original project will also be changed accordingly.

Attention:
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The laser parameters and camera parameters are saved separately. The laser parameters are
viewed and saved on the laser information page, and the same applies to the camera page.

10.6 Check fail

If there are still issues, please save the "Logs" folder under the
"C:\Users\Public\Documents\CoPre" path and contact technical personnel/after-sales for
assistance.

The path diagram is as follows:

11 Reconstruction

This chapter describes the main process of reconstruction. These include AT, Mark, DOM,
and Model

11.1 Aerial triangulation

Description
The image results generated by processing module can do AT processing, which can be used
for GCP mark, DOM building and model building.
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Steps
 Select the result node generated in the preprocessing module (needs to contain

image data), click “Reconstruction -> AT”.
 The AT dialog box will pop up, as shown in the figure below, select the scene.
 Set the plane and height accuracy respectively.
 Click OK to start the AT processing.

 During the AT processing, the progress bar will be displayed below the result node.
When the progress bar reaches 100%, the AT processing is completed, and the
corresponding AT node will be added to the Resources.

 After the AT processing is completed, you can right-click the AT node and select
Show Connection Point to check the matching of the image track and image after AT.
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Notes
The image POS after AT is displayed as green color, and the image matched points are
displayed as RGB color
 After the AT is completed, you can right-click the AT node and select “AT Report” to

view the AT report.

11.2 GCP Mark

Description
Import the image control points and mark the image, can optimize the AT and improve its
absolute accuracy.
Steps
 Select AT node, click "Reconstruction -> Mark".
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 Import control points in the GCP Management view, you can see the total number of
pictures corresponding to the control point.

 Double-click the control point need to be marked, the software will load the pictures
thumbnail corresponding to the control point.

 Click to select a picture in the thumbnail window, the selected picture will be loaded
into the Mark View, use "Ctrl + left button" to mark the point.

 After a picture has been marked, the checkmark at the corner of the picture will turn
green, indicating that the picture has been marked.
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 After the control point marked more than two pictures, the number of marked
pictures and the marked error will be displayed in the control point list, and the
control point will be automatically checked

Notes
Only the checked control points will participate in the Aerial triangulation optimization.
 When all control points are marked, you can click “AT Optimization” to optimize the

current AT node.

11.2.1 GCP Match

Description
During the GCP marking. If more than two pictures are marked, the software will predict the
position of the control point on unmarked picture. If the predicted location is very accurate,
you can use the “GCP Match” function to automatically mark the unmarked pictures.
Steps
 After marking more than two pictures, the control point position of other pictures

will be predicted.

 Click the “GCP Match” button, the software will automatically check all the pictures
without marked.
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 If you find that some pictures have inaccurate marked results, you can click the check
mark of the picture thumbnail, the green check mark will turn black, indicating that
the picture will not participate in the AT optimization processing.

11.3 Build DOM

Description
DOM result is generated from image data, which can be generated at the AT node.
Steps
 Select AT node, click "Reconstruction -> DOM".

 Set the relevant parameters in the pop-up window, click OK, the software will start
DOM processing.
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 DOM setting: If you check adaptive resolution, the software will automatically
calculate the resolution of the DOM, if you check custom resolution, the software
will output the DOM according to the set resolution.

 After the DOM processing is completed, the corresponding DOM node will be
generated. You can right-click the DOM node to select load DOM, and the software
will automatically load the DOM data corresponding to the current node.
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11.4 Build Model

Description
Model result is generated from image data, can only be generated at the AT node.

11.4.1 Reconstruction

Steps
 Select a AT node, click "Model".

 Set the relevant parameters in the pop-up window, click OK, the software will start
Model processing.

 Model settings: Including tile settings, coordinate origin settings, block settings, and
output DOM.

 Data source: Select according to the corresponding data, Lidar can be checked,
image data source is required;

 Tile: There are two methods: adaptive and custom. When "adaptive" is checked, the
software will automatically calculate the appropriate tile size according to the
current remaining memory of the computer. When "Custom" is checked, the
software will calculate the required memory consumption according to the current
size of the tile and click the "Confirm" button on the right.
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 Output DOM:When building model, you can output DOM incidentally. When
checked, the DOM data will be output after the model is built.

 After the Model processing is completed, the corresponding Model node will be
generated. You can right-click the Model node to select load Model, and the
software will automatically load the Model data corresponding to the current node.

11.4.2 Reprocess

Steps
 Click ”ReModel” on the model node

Notes:
The modeling data needs to be reloaded after remodel.
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12 Tools

12.1 Data Copy tool

The data copy tool can automatically copy raw data from the device.

Steps：

Different devices have different data storage disks. For details, please refer to the user
manual of the actual device in your hand.

 Connect the data storage card with card reader to the computer, the computer will pop
up disk ALPHA_SYS.

 Connect the camera to the computer with the type-C cable, the computer will pop up
two disks: CAM_M and CAM_SYS.

 Click“Tools->Data Copy”；

 Select the corresponding parameters：
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 For current AU20, AlphaPano and AA10 units, please manually select the mount carrier
before data copy.

 If you have selected the user defined carrier type option, you need to manually set
the parameters.

 Set parameters as shown below.For details, please refer to the user manual of the
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actual device in your hand.

 After setting up, you can check the project data of the device in the data column on
the left. Select one or multiple sets of data, and you can see the corresponding
camera, laser and GPS data on the right side.

Notes
 Double-click on a photo to view the current photo.
 Create the directory and select the copy path.
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 Click the copy button, CoPre will automatically copy the selected sets of data.

 After all sets of data are copied or the storage space is insufficient, you can click the
format icon in the upper right corner to format the disk.
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12.2 Data quality check

Description
Used to detect data loss and jump of Lidar and IMU, and detect whether the images are
missed.
Steps
 Click ”Tools→Data Check”, the data check window will automatically pop up;

 Click “Import” button to import the data to be checked;

 Check the items to be checked, including Lidar data, camera data and IMU data,then
click ”Check”button.

 Wait until the progress bar reaches 100%, click can open the “Source Data

Quality Report”, as follow:
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 Import：Import the data to be checked, can import multiple projects at the same
time.

 Lidar data check:
(1) AA450(lv、pcap format)：If the data packet is lost for more than 100 and time jump
more than 0.0125s ,Copre decides there is a problem with this data.
(2) Hesai XT16、Hesai XT32(pcap format)：If the data packet is lost for more than 100 and
time jump more than 0.02s(XT16) , 0.01s(XT32),Copre decides there is a problem with
this data.
(3) Riegl：If the data packet is lost for more than 1 and time jump more than 0.3s ,Copre
decides there is a problem with this data.
(4) LT：If the data packet is lost for more than 1 and time jump more than 0.1s ,Copre
decides there is a problem with this data.

 camera data check:
Check the CHCNAV self - developed camera and Ladybug camera to see if the number of
photos and TRG is the same.

 IMU data check: If the Imr data packet is lost for more than 1 second and time jump
exist,CoPre decides there is a problem with this data.

 Check：Click ”Check” button to start checking data.
 Delete：Right-click the imported project to delete the selected project.



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 230

12.3 POS Optimize

Description:
When processing data from AP5, check the POS optimization function, use SLAM and INS
tightly coupled solution to improve POS accuracy, can repair POS jumping.

Steps:
 Click Tools→POS optimize;

 Choose the project file path, and CoPre will automatically detect the paths of the
Post file and IMU file.

 Check if the automatically selected post file is the one to be optimized. Once
confirmed, click "OK".

 After the progress bar is completed, a Post file with the _SLAM suffix is generated
under the selected Post file path, that is the optimized file.

12.4 Point cloud thickness optimization

Description
Only used for data from AA9、AA10、AA15、AA450（AA450Pro）、Alpha3D、VA3 and AU10,
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can reduce the thickness of point cloud.
Steps
 Click ”Tools→Point Cloud Optimize”, the Point Cloud Optimize window will

automatically pop up;

 Set Coordinate Type and Carrier Type.
 Import the point cloud that needs thickness optimization, can import las, laz, and

codata format.
 Set thickness optimization parameters, including Grid Sampling,Grid Size (m),Max

Thick (m),Merge Files and File Formart, please see detailed parameter description
below.

 Set Output Directory.
 Click Start to start thickness optimization，wait until the progress bar reaches 100%,

can check the result in the PointCloudRefine folder of the Output Directory path, as
follow:
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 Coordinate Type: Can select projected coordinate system, geodetic coordinate
system, space rectangular coordinate system, topocentric coordinate system ,the
default is projected coordinate system.

 Carrier Type: Can select UAV or Carset,the default is UAV.
 PosL File: Point cloud form car set need import PosL file.
 Source Files: Import the point cloud that needs thickness optimization, can import

las, laz, and codata format.
 Grid Sampling: Check by default.
 Grid Size (m): Need to check Grid Sampling first, the bigger the value, the less the

point cloud.
 Max Thick (m): He upper limit of point cloud thickness that the algorithm can

optimize, the optimization result may not be good for point cloud whose thickness
exceeds this value.

 Min Rod Height: This parameter is used to determine whether a pole undergoes
thickness optimization. Poles exceeding the minimum height will be subjected to
thickness optimization, while retaining their arc-shaped features.

 Merge Files: Check by default, point cloud after thickness optimization will be
merged into one file.

12.5 Points Optimize Tool

Description

This tool can only be used for AA10, AA450 (AA450PRO), Alpha3D, VA3, and AU10 data, and
this tool can effectively reduce the thickness of the point cloud;
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12.6 CS Manager tool

The “CS Manager” tool is mainly divided into two parts which are parameter calculation
and coordinate conversion, and they separately support coordinate conversion parameters
calculation and point coordinate conversion between different coordinate systems.

12.6.1 Coordinate conversion

Main functions

Click the “CS Manager” tool, then the coordinate conversion window named “CoCoord”
pops up .

The coordinate conversion contains five function bars which are “Source Coordinate
System”, “Conversion Method”, “Target Coordinate System”, “Source Coordinates” and
“Target Coordinates”.

Description

1. According to the different types of coordinate system, the types of the

coordinates are divided into spatial rectangular coordinate (XYZ), geodetic coordinate (BLH)
and projection coordinate (NEH). When conducting the coordinate solution operation, it
should be noted that the source coordinate system needs to be in the same format as the
coordinates of the known points, and the converted coordinate format needs to be same as
the format of the target coordinate system;

2. There are four types of conversion methods, which are datum transform, plane

calibration, elevation fitting and grid method:
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(1) Datum transform is converting the three values of x, y and z, and the methods
include “Three Parameter”, “Seven Parameter” and “Strict Seven Parameter”;

(2) Plane calibration is converting the two values of x and y, and the methods include
“Four Parameter” and “TGO Horizontal Adjustment Method”;

(3) Elevation fitting is only converting the value of z, and the methods include “Fixed
Error Correction”, “Plane Fitting” ,”Curve Fitting” and “TGO Horizontal Adjustment Method”;

(4) The gird method is dividing the plane into different blocks with the same size and
different elevations, and using the grid file can interpolate the coordinate points according to
the grid to obtain the elevation data of corresponding points.

Steps
 Open the “CS Manager” tool, and then set the coordinate types of the source

coordinate system and target coordinate system;
 Click the “Coordinate System Settings” button for the source coordinate system, set

the coordinate system for the original coordinates. As the following picture shows,
the set coordinate system is WGS84/geodetic coordinates;

 Click the “Coordinate System Settings” button for the target coordinate system, set
the coordinate system for the conversion target, at the same time input the
parameters used for coordinate conversion. After all the settings are set, click the
“Confirm” button;

 After clicking the “Confirm” button, you can see the conversion parameters that
have been enabled in the “Conversion Method” part;
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 Click the “Load point/point cloud files” button to import files, or you can also
manually input the point coordinates before conversion;

 Click the“Convert Coordinate”button, then you can obtain the converted points or
point clouds;

 At last you can directly copy the concerted result from the current interface or click
the “Export” button to export the result;

Matters needing attention

1. In scenarios where the projection coordinates are converted using different ellipsoids, the
datum transform method should be adopted.

(1) Processing process

Convert projection coordinate to spatial rectangular coordinate under the original
ellipsoid, then adopt the datum transform method to convert the spatial rectangular
coordinate under the original ellipsoid to the spatial rectangular coordinate under the target
ellipsoid, at last convert the spatial rectangular coordinate under the target ellipsoid to
projection coordinate.

(2) The reason why it is necessary to convert to the spatial rectangular coordinate for
datum transform:

Because the ellipsoidal parameters of different ellipsoids are different, but the
projection coordinate is the projection transformation result under a certain ellipsoid. If
directly using the “Four Parameter” method to conduct the coordinate conversion operation,
the converted coordinates may be wrong; Similarly, when using the “Four Parameter”
method, the operation must be conducted under the same ellipsoid.

2. The already set and used conversion parameters will be displayed in the “Conversion
Method” part in the main interface, before the coordinate conversion operation please
confirm the conversion method to be used;
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3. Switching the type of the conversion coordinate or importing the point cloud will empty
the existing coordinates, so before the coordinate conversion operation please confirm the
coordinate type is correct;

4. When the type of the original coordinate is projection coordinate, the projection mode
can be switched in the “Coordinate System Settings”, but other coordinate types do not
support this function currently.

12.6.2 Parameter Calculation

This function is used to calculate the conversion parameters. After clicking the
“Calculate Parameters” button, the “Calculate Parameters” window pops up .

Parameter calculation

Description

1. Parameter types and calculation methods

The types of parameters include ellipsoid transform parameters, plane transform
parameters and elevation fitting parameters.

(1) Ellipsoid transform parameters: including “Three Parameter”, “Seven Parameter” and
“Strict Seven Parameter”;

The “Three Parameter” method requires the coordinates of at least one pair of known
points, and is generally used on the area with a small scale. The accuracy of this method
depends on the scope of the task area and decreases as the working distance increases;

The “Seven Parameter” method requires the coordinates of at least three pairs of
known points and the application range is larger, generally greater than 50 kilometers;

The “Strict Seven Parameter” method requires at least four pairs of known points;
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(2) Plane transform parameters: including “Four Parameter” and “TGO Horizontal
Adjustment Method”;

The “Four Parameter” method requires the coordinates of at least two pairs of known
points to calculate the four parameters which are “North translation”, “East translation”,
“Rotation angle” and “Scale factor”;

The “TGO Horizontal Adjustment Method” method requires at least three pairs of
known points to calculate the six parameters which are “North origin point”, “East origin
point”, “North translation”, “East translation”, “Rotation angle” and “Scale factor”;

(3) Elevation Fitting Parameters: including “Fixed Error Correction”, “Plane Fitting”, “Curve
Fitting” and “TGO Horizontal Adjustment Method”;

The “Fixed Error Correction” means translation, and this method requires the
coordinates of at least one pair of known points to calculate the parameter “Fit parameter
A”;

The “Plane Fitting” method requires the coordinates of at least three pairs of known
points to calculate the three parameters which are “Fit parameter A”, “Fit parameter B” and
“Fit parameter C”;

The “Curve Fitting” method requires the coordinates of at least six pairs of known
points to calculate the six parameters which are “Fit parameter A”, “Fit parameter B”, “Fit
parameter C”,“Fit parameter D”, “Fit parameter E” and “Fit parameter F”;

The “TGO Horizontal Adjustment Method” method requires at least three pairs of
known points to calculate the five parameters which are “Origin North”, “Origin East”, “Slope
North”, “Slope East” and “dH”.

2. The coordinate format in the parameter calculation interface adopts the coordinate
format in the coordinate conversion interface. Please make sure that coordinate format,
ellipsoid type and projection mode are correct before importing files;

3. The already set conversion parameters in the coordinate conversion operation do not take
effect now. After the calculation is completed, click the “Confirm” button to use the
calculated parameters to update the conversion parameters set previously in the coordinate
system settings;

4. When the coordinate format in the imported file is not same as the selected coordinate
format, the coordinate values with incorrect coordinate format are displayed in red on the
file import interface. Please modify the coordinates according to the red prompts, and if not
modified, the default initial value will be adopted;

5. When modifying the imported coordinates in the parameter calculation interface, if the
modified coordinate format is not same as the selected coordinate format, the software will
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pop up red prompts. If the coordinate format is not modified as the correct coordinate
format, the calculation operation can not be performed.

Steps
 Open the “CS Manager” tool, by clicking the “Calculate Parameters” button in the

upper part of the interface you can enter the “Calculate Parameters” interface;
 Select the type of the parameters participating in the calculation, and you can select

“Ellipsoid Transform Parameters”, “Plane Transform Parameters”, “Elevation
Fitting Parameters” or “Ellipsoid Transform Parameters” + “Elevation Fitting
Parameters”;

 After these settings are set, import the control point pairs, or manually input the
control point pairs after inserting blank lines. The coordinate format of the control
point pairs here needs to be same as the coordinate format in the coordinate
conversion interface;

 After inputting all the control point pairs, click the “Calculate” button;
 Then the calculated parameter values and residuals will be displayed in the rightest

panel;
 Click the“Export Report”button, the information in the calculated result panel will

be exported as the file in the txt format; Click the“Export Parameters”button, and
the file in the tp format used to import the coordinate conversion tool will be
generated. Click the “Confirm” button, then the calculated parameters will be
directly applied to the coordinate conversion tool.

12.7 Mask tool

Description
User can create a mask file to filter vehicle body for panoramic pictures.
Steps
 Click “Tools – Mask Tool” to open panoramic image mask tool interface.
 Click “Load Pano” to import a panoramic picture first. Then use “Ctrl” button with

left mouse to draw on picture to filter vehicle body. Use Ctrl button with right mouse
can cancel last step.
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 After finish drawing, click “Start Mask” to create a mask picture. User can click
“Reset” to recreate one.

 Finally, click “Save Template” to save this mask file and the file name is
“MaskImage.jpg”.
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12.8 Ortho Color Tool

Description

This tool can be used to color the point cloud using the orthophoto;

Requirements for using the tool

1. The input orthophoto and point cloud should be in the same location;

2. Only the projection coordinate is supported for the point cloud;

Steps

 Click the “Ortho Color” button, then the tool window pops up;
 Input the file path of the orthophoto and the file path of the corresponding

projected point cloud;
 Set the output path of the colored point cloud, and set whether to check the

“Remove Unshaded Points” option and the file format, and the default file format is
las format;

 Click the “Start” button, and wait until the progress bar loads to 100%, which
symbols the completion of the processing.
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12.9 PFD

Description

Import the folder of vehicle-mounted photos and output the photos with license
plates/faces blurred.

Comparison of photos before and after privacy blurring:
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13 Software Helper

User can check more information about software on “Help”.

13.1 Language

User can switch software language here: Chinese, English and Russian.

13.2 Manual

User can find latest software user manual under this option.

13.3 Update Info

User can check release note about new features and solved bugs.

13.4 License

User can check software license and machine ID under this option.
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13.5 About

User can check current software version and detect latest version to upgrade. You can set up
automatic software updates and view third-party library license information.

13.6 Resource Pack Updates

Description
Supports online download of resource packages and online/offline updates to use the
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corresponding functions of the resource packages.
The resource package functions supported by the current version: insta360 solution, 3D
Gaussian modeling, language, Image AI Processing, Parameter Configuration, Coordinate
SystemManagement, Grid Files and Handheld AI Processing.

Steps
Method 1: Network environment
 Click the "Help->Resource Pack->Resource Pack Downloader" button (or jump to the

"Resource Pack Downloader" page by using the function of not downloading resource
packs);

 Select the resource package you want to download, for example: 3D Gaussian modeling;
 Click "Download" to directly download the latest resource package supported by the

current CoPre version;

 Wait for the download and installation to complete, and the resource package function
can be used normally.

Method 2: No network environment
 Click the download button of "About->Resource Package->Resource Package

Downloader" (or jump to the "Resource Package Downloader" page by using the
function of not downloading the resource package);

 Select the resource package you want to download, for example: 3D Gaussian modeling;
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 After clicking the ">" next to the "Download" button, click "Manual Installation", select
the resource package file provided by technical support, and start downloading the
resource package;

 Wait for the download and installation to complete, and the resource package function
can be used normally.

Note: Due to the compatibility issue between the resource package and CoPre version, you

need to update to the latest CoPre version to download a resource package that is not

supported by the current CoPre version.

13.7 Log Packer

Description
Export all log files or the log file of the current project.
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Steps
1. Click "Help -> Log Packer".

2. Select the files to be packaged, set the export path, click "Export", and the exported
files will be stored in the project folder.

Log file

14 Common Shortcut Keys

This chapter describes the shortcut keys commonly used in trajectory view,
three-dimensional view, and control point view on the CoPre main interface.

14.1 For Trajectory View

 Mouse wheel: Zoom in/out POS trajectory.
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 Mouse right button: Long press to move POS trajectory.
 Space button: Full screen trajectory.
 Ctrl + Mouse left button: Finish polygon select/distance measurement.
 Esc: Undo the last option during polygon select/distance measurement.

14.2 For 3D View

 Mouse wheel: Zoom in/out point cloud data.
 Mouse left button: Rotate point cloud data.
 Mouse right button: Move point cloud data.
 Double click left mouse: Centered mouse location.
 Space button: Full screen point cloud data.
 Ctrl + Mouse left button: Select one point under paired process.
 Shift + Mouse left button: Select intersect point based on two lines under paired

process.
 Ctrl + Mouse right button: Pop on paired point window after select points.

14.3 For Cross Section View

 Shift + Mouse left button: Select two points and measure distance.
 Mouse wheel: Zoom in/out point cloud data.
 Mouse right button: Move point cloud data.
 Double click left mouse: Centered mouse location.
 Space button: Full screen point cloud data.
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15 Parameter settings

This chapter describes the Settings of CoPre parameters and recommended Settings.

15.1 POS accuracy curve

Float/Fixed Ambiguity:
Fixed: Sometimes the solution without solving an integer has a value is between 3 and 5. The
precision of the fixed solution is greater than that of the float solution.
Float: The ambiguity is not fixed, at this time the phase accuracy and pseudo-range accuracy
are roughly the same, and the overall accuracy may be at the decimeter level or meter level,
with a value below 3. The fixed solution accuracy is greater than the floating point solution.
This is an internal consistency accuracy that can only be used as a rough standard for judging
accuracy. Sometimes, even when the solution is converging or stable, it may also be at the
centimeter level.
Float (Convergent): The positional error is quite large, with the overall error at the meter
level, gradually converging to the decimeter level.
Float (Stable): The positional error has converged to the decimeter level, and
decimeter-level positioning can basically be achieved. However, the ambiguity cannot be
fixed or fixed too little, which cannot achieve centimeter-level accuracy.
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Quality Factor: The quality factor of POS solution is determined according to the fuzziness
fixation and the estimation accuracy, the range is 1-7 and the smaller the better, the value
less than or equal to 2 is better.

DOP：The position accuracy factor, which reflects the satellite distribution, the range is 0.5-99
and the smaller the better, the value less than 3 is better.
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Estimated Position: The information of the accuracy within the filtered solution can reflect
the error size of each position to a certain extent, and the smaller the value the higher the
accuracy.

Estimated Attitude: The information of the internal conforming accuracy of the filtering
solution can reflect the error distribution of each attitude angle to some extent.
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Combined Separation: It represents the position difference value between forward and
reverse solution. The forward and reverse positions are related to many factors and are more
difficult to quantify. The accuracy of the vehicle point cloud is required to be within 10cm,
and if the forward and reverse positions are more than 30cm, it can be considered that there
may be anomalies.

Attitude Separation: Represents the attitude difference value between forward and reverse
solution, related to inertial guidance accuracy, forward and reverse attitude should generally
be in fractions of an arcmin, if greater than 3 arcmin must be abnormal.
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Calculated Satellites: how many satellites involving solving POS.

Tips: The combined separation and attitude separation do not really reflect the error size,
and if the forward and reverse error is large, the probability of the solution result is
anomalous

15.2 POS Optimize

Introduction：
When project is going on, it’s possible that POS on vehicle jumps at parking place. It leads to
points cloud distortion, so users are able to use POS Optimize function to smooth and repair
POS to further solve distortion.
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Parameters Description：
Smooth Distance：Extending distance at the jump to smooth.
Check Threshold：Any POS jump higher than this threshold would be repair, the minimum
value is 0.01m.
Convergence Interval：Determinate 0.01m as default，it represents allowed jump after POS
optimize, which will be less than this Convergence Interval.
Time：POS jump range could be selected by time. The default range is detected by Algorithm.
Check Again：The first check is automatic, users are able to modify all parameters and check
again. The blue area on the main display is jump range.
Repair：Select time range on the column to repair the POS, figure below is before and after
comparison.
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15.3 Filter Settings

15.3.1 【MTA Data】

In measurements using the pulsed time-of-flight principle, there exists a theoretical
maximum range of distance measurement which is determined by laser emission frequency
and the light speed. Before the echo signal generated by the previous pulse has returned,
the next pulse signal has been sent. So that the receiver cannot determine echo signal from
which pulse signal has returned, leading to uncertainty in the measurement, which is known
as Multi-Time-Around (MTA) echo.
After receiving the echo pulse, MTA algorithm in CoPre automatically calculates the real
distance to the target based on the echo patterns. The multi-time-around algorithm
determines the maximum number of multi-periods that can be supported according to the
detection capability at different point frequencies.
The following figure shows the point clouds of AU20 laser without multi-time-around
solution (left) and after multi-time-around solution (right)

Tips:
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（1）AA1400/AA2400/VZ2000i: Convert rxp to sdcx and must insert RiUNITE 1.0.3 dongle;
（2）AU900/AA1300/Alpha3D: Check the MTA, then insert the RiUNITE 1.0.3 dongle and
convert rxp to sdcx. If do not check the MTA, also no need insert the RiUNITE 1.0.3 dongle
and conversion.

15.3.2 【Circle Noise Filter】

The Circle Noise Filter is not selected as default, users are able to use it when noise still after
MTA Filter. There are 4 options: Close, Low, Medium, High.
Low Option and Medium Option are used on most of noise occasions caused by Aerosols.

There would be slight noise in points cloud on plain ground, these points can be filtered by
High selection.

Figures below are comparison between medium and high filter at edge.
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Tips:
（1）For sparse and edge area, high filter will delete useful points.
（2）This parameters aims to AU20 device.

15.3.3 【Mapping Unresolved Targets】

Mapping Unresolved Targets for AA1400 data, mainly for power line data .

Tips:
This parameters aims to Rigel.
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15.3.4 【FOV Filtering】

Algorithm Principle:
Filter point clouds outside the FOV range.
As shown in the figure below: the red range is the field of view 90°area, the green range is
the field of view 120°area, if the field angle is set to 90°, the points outside the red range
will be filtered out; if the field angle is set to 120°, the points outside the green range will
be filtered out.
Algorithm Schematic:

Actual Performance:

This setting is only valid for airborne radar data, the default value of AA450 is 60°, AU20 is
360°, and other devices is 120°. The larger the field angle, the larger the point cloud range.
The following figure shows the left set the field angle to 120°, the right set the field angle
to 60°
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15.3.5 【3D Distance Filtering】

Algorithm Principle:
Determining the 3D distance minimum and maximum threshold will filter out points that are
not within range of the scanner's 3D distance. The 3D distance filtering origin is the center of
the laser and value is positive downwards;
Algorithm Schematic:

Actual Performance:
3D Distance Filtering is a default Selection, could be modified as individual lidar device type.

15.3.6 【Intensity Filtering】

Algorithm Principle:
Filter out point clouds that are not within the setting range according to the grayscale value.
The parameter values can be modified as needed, with different default parameter values for
different laser types;
General point clouds with anomalous reflectivity can be filtered by intensity filtering
Actual Performance:
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15.3.7 【Height Distance Filtering】

Algorithm Principle:
Filter out point clouds that are not in the elevation filtering range. The elevation filtering
origin is the laser center, positive upwards;
Algorithm Schematic:

Data Actual Performance

By measuring the noise point above 100m from the point cloud, the range of the maximum
value can be set to [-100, -1] according to the flight height of 100m.
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Tips: Height Distance Filter is mainly determined according to the noise height and the
distance between laser and noise.

15.3.8 【Noise Filtering】

Algorithm Principle:
Within the cover radius, if the neighbor points number is less than 5, the algorithom will
fliter this noise. As shown in the figure below: the number of neighbor points within the
radius d of the yellow point is 1; there is no neighbor point within the radius d of the green
point, so these two points will be filtered out, and the red point within the radius d has 5
domain points, the point will not be filtered out.
Algorithm Schematic:

Actual Performance
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If the jumping noise filter distance threshold is set to 1m, it means that the point is within a
sphere with a radius of 1m. If the number of neighboring points is less than 5, the point will
be filtered out. The following figure shows the comparison before and after setting the
jumping noise

Tips:
Generally, flying spots can be filtered by jumping noise. If the point cloud is relatively sparse,
you need to increase the threshold appropriately. It is recommended to determine it larger
than the maximum point intervals, otherwise useful points will be filtered out.

15.4 Colouring Parameters
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Colouring Parameters Description：
RGB Information Range: The default ranges 0~65535，or 0~255. color range determines
information storing space and abundance.
Remove unshaded points: Delete points which are not colored.

Filter Tower Shade : Default selection, it solve the problem that the tower color is assigned
to the ground when the power line data is colored (the option of the vehicle data is disabled),
the comparison diagram is as follows:

Trigger Filter Interval: This setting is only valid for MMS vehicle data, and the default value is
10m. When the on-board point cloud coloring is blocked by the front or rear of the car, this
parameter can be appropriately increased.
Cover Radius: This data is only valid for vehicle-mounted data. The default determination is
8.5m. When the MMS point cloud coloring is blocked by the front or rear of the vehicle, this
parameter can be appropriately increased.
Mask:Mask Tool works on MMS vehicle data, users are able to use it to make mask based on
a panoramic picture. Press Shift+Left Click to draw a mask.
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Drawing Illustration

Camera Selection It’s possible to select individual camera to colorize the point clouds.
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15.5 Refine

Refine function allows selecting pioneer point next to GCP to refine point clouds to improve
absolute accuracy.

15.5.1 【Mode 1: Refine POS(position only)】

Algorithm Principle:
This function refine position information in PosT file, mainly applied on MMS vehicle data.
Algorithm Schematic

Actual Performance

Correction Mode 1 Parameter Description
The distance threshold is set to 500m by default, and the smoothing threshold is set to 50m
by default. That is, when the distance between GCP is less than 500m, the position error
value of POS is calculated according to the error of adjacent GCP. When the distance
between GCP is bigger than 500m, it smooths the area in a 50m radius neighbor range of
GCP.
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15.5.2 【Mode 2: Refine POS(position and attitude)】

Algorithm Principle:
This function refines position and attitude information in PosT file. It embeds GCP
coordinates to solve POS along with attitude from INS, and position from GNSS. It applies on
strip MMS vehicle data.
Algorithm Schematic
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15.5.3 【Mode 3：Refine Points Cloud (Based On near control point

error)】

Algorithm Principle:
Sampling neighbor GCP errors to correct points. It applies to polygon plain area or urban
area with enough GCP. Need to determine smooth distance. The outward expansion distance
of the GCP convex hull boundary line, from the GCP convex hull boundary line to the
outward expansion boundary line gradually tends to 0. The default value is 50 meters, that is,
the boundary line of the GCP is expanded by 50m, and the boundary line from the boundary
line of the GCP to the 50-meter boundary line that is expanded gradually tends to 0. If the
error of the GCP is large, the value can be appropriately adjusted to make the correction
amount of the expanded point cloud transition smoothly.
Algorithm Schematic:

Actual Performance:
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15.5.4 【Mode 4：Refine Points Cloud（Point Cloud Overall Offset）】

Algorithm Principle:
The overall rotation offset of the point cloud is applicable to the scene where there is a
relative position offset between the GCP and the point cloud. When using this algorithm, try
to ensure that the GCP cover the survey area and are evenly distributed.
Algorithm Schematic:

Actual Performance:
Before correction, the GCP is 100cm away from the point cloud. After Mode 4, the GCP is on
the point cloud. The figure below is the comparison before and after Mode 4.
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15.6 Reconstruction

15.6.1 【AT】

Parameters Description:
Scene: Select the scene according to the data type. The scene is divided into three types:
town, mountain and plain. The number of connection points extracted by the software is
different when the scene type is different.
POS Accuracy：Set the accuracy of plane and elevation when solving, the default is 0.05.



CHCNAV COPRE 2 USER MANUAL | 2026-05 P a g e | 269

15.6.2 【DOM】

Parameters Description：
Data Source：Select according to the corresponding data, where the laser data source is only
optional in the high-efficiency mode, and the image data source is mandatory;
Mode Setting： Contains two modes of high efficiency and high quality. High efficiency
generates orthographic speed quickly, but the effect is poor. High quality generates
orthographic speed slowly, but the effect is better.
Scene: Contains 3 scenes of town, mountain and plain, select according to the actual data
scene type.
POS Accuracy：The allowed range of accuracy.
DOM Setting： Select Adaptive Resolution, the software will automatically calculate the
resolution of the orthophoto, if you select Custom Resolution, the software will output the
orthophoto according to the set resolution；

If there are three setting methods for orthorectification in the results, adjustment, and
correction nodes, corresponding to the three modes, as follows:

Mode 1: Select the point cloud and image as the data source, and the default is only
the high-efficiency mode, which is orthographic fast spelling;

Mode 2: Select the image as the data source, and select the high-efficiency mode. This
mode quickly generates orthophotos, but the quality of the results is average; it is suitable
for non-urban areas

Mode 3: Select the image as the data source, and select the high-quality mode. This
mode will first short and then do orthorectification internally, so the output effect is good
and the quality is high, but it takes a long time.
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Mode 1 2 3

Data Source
Points Cloud &

Images
Images Images

Solving Mode Efficiency Quality Quality

Time Medium Short Long

Scenarios All Non-Urban All

Shortage
Need point cloud

data.
Quality of texture is

not good

Quality of Water
and vegetation is

not good

Tips:
Generate DOM based on AT is mode 3 above.

15.6.3 【3D Modeling】

Parameters Description：
Data Source: Select data according to project, laser is optional.
Mode Setting: Mode Setting includes high-efficiency and high-quality modes, the
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high-efficiency generation model is fast, but the effect is poor, and the high-quality
generation model is slow and the effect is better.
Block： There are two ways: Adaptive and Custom. When self-adaptive is checked, the
software will automatically calculate the appropriate tile size according to the remaining
memory of the computer. When custom is checked, set the tile size and click the
confirmation button on the right, and the software will The required memory consumption
will be calculated according to the size currently set, and the estimated memory usage
should be less than 60% of the computer memory.
Output DOM：It will output DOM simultaneously with model.
Tips：

There are 2 modeling methods at AT node like below:

Method Method 1 Method 2

Data Source
Points Could &

Images
Images

Mode Efficient Quality

Time Cost less more

Scene All Scene

Shortage Distortion on water and vegetation

Advantage Efficient
Higher

Completeness
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16 Common problems and solutions

 CoPre 2 cannot display trajectory, failed to load plugin: TrajectoryControllerLib.dll
Reason: The registration of the track view module fails or is not registered. It usually appears
when CoPre 2 is installed with antivirus software.

Solution:
1. Close the antivirus software and reinstall CoPre 2, This method is suitable for the installed
version.
2. Open the installation directory of CoPre 2, find the regMapWinGIS.cmd file in the
mapwingis folder, run it as an administrator, and then run regasm.bat in the installation
directory as an administrator, this method is suitable for the portable version.
3. If the manual registration also fails, run cmd with the administrator and manually enter
“regsvr32 X:\\...\CoPre2\Release\mapwingis\MapWinGIS.ocx “to register.
Note: This is an example path; replace it with the actual file path when using.
 The project raw path has changed
Reason: If the data is stored in the mobile hard disk for processing, if the computer is
changed, the drive letter corresponding to the mobile hard disk may change, and the data
path will also change, or the folder name and data path will also change when the computer
is changed. When the task is loaded, the corresponding original data loading failure will be
prompted.
Solution: Re-import the original project.

 The task path is changed and cannot be loaded through historical tasks
Reason: The data is stored in the mobile hard disk, and the drive letters displayed on
different computers are different, or the folder name is changed artificially.
Solution:
Method1: Manually select the task file (*.cpr) by opening the task.
Method2: Do not open the software through the shortcut, directly double-click the task file
(*.cpr), and the software will display the double-clicked task.

 POS processing failed
Reason: The independent graphics card is not turned on.
Solution: Switch the integrated graphics card to the independent graphics card and reopen
the software to process POS.

 Add missing data
Reason: The original data is missing when importing the data, so I want to add the missing
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data.
Solution: Put the new data into the corresponding directory of the project and refresh the
project.

 The project files between multiple tasks are merged into one task
Reason: The data wants to be placed under a task for superimposed display for comparison
Solution: By importing the preprocessing project (*.solve), it can be merged into a certain
task (the original project can also be imported directly). At this time, task 1 will contain the
projects under task 2/task 3/task n. (Note: The merging here is not the merging of file paths
in the true sense, but the file index is changed, so if the path of task 2 / task 3 / task n is
changed after the merging, you still need to re-import Pre-process the project to task.
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 The calibration parameters and the equipment do not match
Reason: The calibration parameters in SCAN/Scanner1 or IMG/Camera1 in the project
directory do not match the equipment.
Solution: Contact CHCNAV support team to check.

 Process pictures and show error: Ladybug SDK error, operation failed.
Reason: It may be that the original file path of ladybug has Chinese symbols, or the file is
damaged.
Solution: First check whether the pgr path of the original ladybug stream file has a Chinese
path, if not, copy it from the device again.

 Process point cloud and show error: Riegl SDK error, unknown sub package V3.6 error.
Reason: The original laser .rxp file is damaged.
Solution: Re-copy the original laser data from the device to rule out whether it was damaged
during the data copying process. If this error is reported after the re-copying, it may be that
the collected data is faulty.

 Import .csv format GCP file wrong.
Reason: The format of the control point of the .csv file is wrong.
Solution: Because some of the wrong format of .csv cannot be viewed through excel table,
you can copy the content in .csv to .txt text for viewing, check the format of the control point,
and re-import the control point after confirming that there is no problem.

 AT failure issue
Reason: Check if a non straight flight path trajectory was selected during data calculation.
This trajectory is a takeoff and landing phase, which will affect the processing of air traffic.
Automatic selection of trajectories may also choose non direct route trajectories.
Solution: Manually remove non takeoff and landing segments, recalculate data, and perform
air-to-air processing.
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